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Introduction

The Assessment Volume documents the comments and
requests received from project stakeholders and clinical
consultants during weekly reviews. This document also
includes the action item and results associated with each
comment or request. This document helps to clearly
document and communicate requested changes by project
stakeholders and ensure changes are captured and integrated
into the final prototype and supporting documentation.
This document has been updated each quarter and
represents our current understanding of the project's
requirements.
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Executive Summary

INTRODUCTION
The Parsons Institute for Information Mapping (p11M),
of The New School received Internal Review Board
approval from The New School on December 14th, 2011.
On February 17th, 2012, p1IM was notified that the IrRB
protocol in support of this project was determined by the
USAMRMC not to involve research activities in accordance
with 32 CFR 219.102(d).

p11M conducted internal “dry runs” with staff to
organize and inform the overall testing effort prior to the
formal testing utilizing subjects. Formal testing began on
July 19, 2012 and concluded on December 14, 2012. By
the conclusion of the usability effort, 10 dry run tests, 20
benchmark tests (used for Time and Path comparisons),
and 24 official interviews had been conducted.

Of the 24 subjects:
o 42% were female, 58% were male;
* 58% were between the ages of 31-45;

* 75% had a 4-Year College Degree (BA, BS)
or higher;

* 83% spoke English as a first language;

* 100% used Web Browsers, 95% used Office
Applications, and 71% used Creative Applications;

* 83% used the computer daily at school or work;
« 88% used the computer daily at home;

« 96% had not used a software package to track
health-related information.

A known limitation of our study as indicated by the
subject demographics was that the population from which
the subjects came from was a university campus. Clearly,
there are differences in the level of education and general
population of active duty military personnel. Subsequent
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usability testing should take this into account; and future
usability studies are planned that should provide better
insight into this key difference.

STUDY DESIGN METHODOLOGY

The usability testing was broken into four groups of

six testers. The idea was that as the subjects identified
usability constraints with the prototype, the application
could be redesigned and reprogrammed thereby providing
a second opportunity to assess not only the effectiveness
of the original design but the effectiveness of the revi-
sion. The subjects were recruited in four groups of six:
Group 1A, Group 1B, Group 24, and Group 2B. Since

the HealthBoard prototype included both a patient and

a provider portal, the subjects were given personas that
were modeled after anticipated user workflows. Since the
test was to be conducted over a 45-minute duration, it was
more effective for evaluation and for the subjects to divide
up the functionality of the HealthBoard prototype across
different groups.

Overall, the iterative redesign of the HealthBoard
prototype based on initial feedback led to notable im-
provement in the completion of tasks between testing
groups. Of the initial 30 identified tasks, 18 of them were
improved, and an additional 6 tasks were flagged for
requiring further redesign beyond the redesigns conduct-
ed during the usability testing.

RESULTS
For analysis, p1iM conducted both qualitative and quanti-
tative data. Data provided the backbone for understanding
fundamental flaws in the original design, while the quali-
tative data helped inform what subjects felt or thought
about the application. Using a software package called
Morae, P11M calculated a number of task-based metrics
including Successful Completion, Task Time: Benchmark
Time, Task Path: Benchmark Path, and Error Rate were
recorded. Testers were also given scorecards following
each task to rate Task Complexity, Visual Design, and Overall
Appeal. These scorecards provided p11m with better insight
into overall user satisfaction. Tasks were judged as
“improved” based if more than one metric were identified
as improving from one round of testing to another.
Overall, subjects responded favorably to the useful-
ness of HealthBoard on average -58%, or 14 of 24 subjects
stated that they would be at least somewhat likely to use
HealthBoard if made available to them. Subjects cited
the most common reason as being the “convenience of
one-stop shopping”; other comments included identify-
ing HealthBoard as an “all in one software on health and
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food!” and provided “ease of communicating with health
provider” Furthermore, 63% (15 of 24) rated the applica-
tion as at least somewhat easy to use. Considering that
these surveys were conducted after subjects had on
average less than an one-hour to work with the prototype,
we believe that this bodes well for dashboard-based
personal health systems.

The dark color scheme and contrast had been identified
prior to the testing as something that some subjects might
have a strong opinion about. On occasion prior to the
testing, some reviewers from the Military Health System
had reflected on feedback they had received on a similarly-
skinned system JANUSs. Based on the usability testing
however, this criticism wasn't uniformly noted by subjects.
A few subjects identified the color scheme as being rather
soothing—“dark color scheme is comforting—not clinical”
or “I like the color scheme; it’s very neutral and adjusted to
my eyes.” One subject commented the “color scheme is oK.
It will be nice to have option. The color scheme seemed
fine” Others did express that they would prefer “brighter
colors, not as monochromatic” or “the color of screen is a
little too dark. It will be better if it's lighter” Based on
further observation and subject comments it became
evident that the experience and visual design may benefit
overall from being more friendly and approachable. One
tester commented “it does look slick, but it does not look
friendly” Another said “if I could change the color, it will
make it a little more friendly” Yet another mentioned:
“Too much gray...looks like a tombstone (laughs)”

These comments generally confirmed that the impor-
tance of providing the user with customizable options.
While some users indicated indifference about the colors
used for the prototype, providing an option for those who
would prefer some level of control over the appearance
would likely satisfy those who would have preferred
lighter backgrounds or colors used in the application. The
HealthBoard prototype has now incorporated an alternate
color scheme which could be further enhanced depending
on where HealthBoard might be used.

HealthBoard has two different “homescreen” views: a
simplified button view and a dashboard view which
contains key data points from each module. The majority
of subjects preferred the button view, saying things like
“[the button view is] a little less cluttered, I think” Another
subject said the widget view “is a bit overwhelming. I like
button view better. [In widget view;] there are a lot of things
on the screen. I'd like to just focus on things. I prefer
button view.” After completing the task to change button
view to widget view, PIIM even observed some testers
revert to back button view.
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PIIM invested significant time and resource into
developing a “Next Steps” feature. The next-step feature
provides recommendations from the patient's provider
team, such as “Schedule Tetanus vaccination.” Initially,
this information was contained in the Medical Records
module, and subjects scored a 83% successful completion
rate when attempting the task. p11M made an effort to
promote the feature to the “homescreen,” hoping to drive
100% successful completion. Unfortunately, the change
that was made put the feature in a “blind spot” of the user
interface, and subjects only scored a 33% successful
completion. When asked what was most challenging, one
tester commented “it was to find the ‘Next Steps’ informa-
tion” Another tester commented: “Looking [for] a history
of Next Steps. Not sure what Next Steps meant.” The term
itself appeared to cause confusion. Since the term may also
be associated by some with advance directives, meaning the
protocol for a person's end-of-life care, we believe that an
alternate phrase is probably more appropriate. The ease of
access to the information held in such a summary screen
does however provide a great opportunity for communi-
cating important information to patients.

The Exercise Module had an aggregate success rate of
71%, compared to the median module score of 81%. One
contributing factor could be the Physical Readiness Test,
with which civilians are unfamiliar. Another could be the
several different types of exercise: Personal Readiness Tests,
Physician Assigned, and Personal. Perhaps only having
Physical Readiness Test and Other Exercises would simplify
the module.

Finally, the interactive trackers in the Vital Signs
occasionally caused problems for subjects. P11M believes
this could be a powerful tool to empower behavior change
through information. In our task the subject was instructed
to create a tracker for the number of cigarettes smoked.
Despite attempted fixes, the task's success rate sunk to
50%. It seems testers do not associate the Vital Signs
module, perhaps taxonomically, with custom trackers or
understood their intended function. An opportunity may
exist to merge Trackers with Next Steps.

OTHER OBSERVATIONS

Improving HealthBoard's nonverbal communication
might also help with engagement. The intention behind
having functionality like Trackers and Next Steps is to
empower behavior change through information. The ease
of access of such information may also encourage use and
adoption of the application. Some companies have within
the past few years developed devices (pedometers, scales,
bracelets) where the information is automatically trans-
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mitted to a reporting application (Nike Fuel, Fitbit, Basis,
and Withings Wi-Fi Body Scale are a few examples).

On a high level, the user experience should be prioritized
according to communication, second data acquisition, then
finally data retrieval. The modules as currently organized
are highly segmented and separated. Comments can be
made in multiple modules but no single place exists to
engage with comments. Creating a single, designated place
for interacting with health care providers in relation to
data (not just Messages) could improve effectiveness. One
way of doing this could be the introduction of something
like the Health Focus block from the Provider Portal into
the Patient Portal.

FUTURE USABILITY EFFORTS

The testing environment was identified as being overall
important to the process. Distractions in the room,
including multiple moderators, equipment and other
items tended to complicate things for subjects. Removing
as much of these factors possible would likely decrease any
anxiety experienced by the subject. While subjects were
offered food and beverages, the addition of light music

to the environment might also lead to a more pleasurable
environment.

In processing the data, Hint Count is one metric that
would have been a useful indicator, perhaps even more
so than Error Rate, would have. A hint is defined as any
additional information, outside the task, dispensed by the
moderator. This could be a good metric in determining
problem areas.

Recruitment proved more difficult and time consuming
than originally anticipated. Multiple no-shows complicated
matters, and the incentive (a $10 Metrocard) may not
have been enough to adequately encourage participation.
Formative testing may lead future tests away from design
changes that negatively impact the usability scores before
they are deployed in a formal testing environment. The
usability testing confirmed for us that HealthBoard could
be an effective way in ultimately improving the likelihood
of patients recording and interacting with their personal
health information.
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Methods -
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USABILITY
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RECRUITMENT
Following our 1rB-approved protocol, P1IM recruited 24
subjects for testing using posters in and around The New
School University (see FIGURE 14 and 1B). Respondents
took a “tear away” containing a link to the study’s website
(http://piim.newschool.edu/ulab).

On the “ULab” website (FIGURE 1C), interested
parties reviewed additional details, agreed to an informed
consent statement, and then completed a Pre-Screener FIGURE 1A: ULab Poster
Survey to participate. p11M then corresponded with the
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FIGURE 1C: ULab Website
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U-LAB [ USABILITY TESTING LAB

Determination - June, July

HEE NS S
Validation - Sept, Oct

* General Items, Settings
(e.g. Change password, Edit Profile)
* Medications
* Appointments
* Messages
* |[mmunizations
* Medical Records

Group 2

O O 9O O O O

Determination - August, Sept

o R O R OE A
Validation - Oct, Nov

* Vital Signs

* Exercise

* Nutrition

* Educational Resources

FIGURE 2: Test Structure

TESTING STRUCTURE

Subjects were divided into four groups of six: Group 1A,
Group 1B, Group 2A, and Group 2B (see FIGURE 2).
Group A represented the testers, and Group B represented
the validators. HealthBoard’s breadth made it difficult to
test the full prototype in a single 45-minute session, plus
these groupings related directly to the schedule of our
engineering effort.

o Groups 1 and 2 tested different sets of modules.

o Group 1 tested Setting (e.g. Change Password,
Edit Profile), Medications, Appointments, Messages,
Immunizations and Medical Records.

« Group 2 tested Vital Signs, Exercise, Nutrition
and Educational Resources.
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MODULE COUNTED NO. TASK
GENERAL (GEN) . & 01 How would you reorder the modules?
. "o How would change the display of the homepage?
. i 03 Please login with the persona you've been provided.
. " 04 Delete a module.
. " 05 Add a module.
VITAL SIGNS (VITALS) . r 01 Tell a doctor their weight on a date.
. " o2 Tell a doctor their weight on the same day last year.
. "3 Record weight and temperature with comment (for yesterday): "Feel sick, have the flu."
" 04 Find help information related to blood pressure.
I 05 Find all the vitals for a specific entry (click node).
. " 06 Add a comment to the past entry.

07 Edit a recorded vital.
08 View a history of all readings (log).

. 09 Remove a tracker.
. i 10 View a comment.
. 6 11 Find a provider comment.
4 12 Re-arrange trackers.
. f 13 View details on a specific tracker (e.g. Weight).
. - What is your weight goal?
. - When were you overweight? How are you doing now?
. f 14 Edit your goal.
. i 15 Change Reference (e.g. BMI vs. Weight Average).
. f 16 How do you view details about your blood pressure?
B 17 Choose a custom date range.
i 18 Change to table view.
. i 19 Does your latest blood pressure reading indicate hypertension?
. ¢ 20 Add a tracker (quite smoking?).
. r 21 Make a tracker entry.
. "o Hide only the trackers your care about.

EXERCISE (EXER) . M o1 Introduce PRT score. Based on this, what do you need to improve?
. 02a How would you find a results from (date)? How would you edit them?
. 02b How long before your next PRT?

. I 03 What have you most improved? What has suffered?
. ¢ 04 What personal exercises are you doing?
(n/a) I 05 Record a PRT result.
. " 06 What is goal?
. £ 07 Add a comment to yesterday's workout.
. " 08 Switch from 1.5 mile run to swim.
. r 09 Find details about your 1.5 mile run.
. T 10 Edit PRT goal.

- Switch from "Satisfactory Goal" to "Good" by the new year.

FIGURE 2A: Cataloguing Tasks (Sample)

TASK CREATION Once candidates were determined, tasks were written
The process of creating tasks began by creating a catalogue into a “narrative form” (see FIGURE 2B).
of available actions from the Design Volume, Product
Requirements Document, and inspection of the prototype
(see FIGURE 2A).
Once all tasks were catalogued they were broken
down into a more manageable set. First, we removed
similar tasks with different contexts; For example, “make
a comment” in Exercise versus Vital Signs. Next, tasks were
prioritized by perceived task importance. The team viewed
it as more important to report taking a medication, and
less important to be able to switch your homepage view.
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[TASK NARRATIVE

-

. (GEND3) Please login with the persona you've been provided.

2. (NUTRO1) For the last six months, you've been using Healthboard to maintain a
healthy weight through diet and exercise. How would you report eating a bowl of
cereal with almond milk this morning?

3. (NUTROS) If you had trouble finding entering what you ate, where would you find

help information?

4. (GEMNO01) Lets go back to the "home screen." How would you put the modules in
order that makes sense for you?

5. (GENO1) Please change the "home screen” to "widget view.”

6. (VITALSO01) This morning you weighted yourself: 182 Ibs. How do you enter that
in?

7. (VITALS02) How much did you weight at this time last year?

8. (VITALS06) Five days ago you made an entry that your weight was 175 Ibs. and
temperature 101°. Go back and add a comment that you “had the flu.”

9. (VITALS10-11) Where would you view other past comments? Has your doctor

left any comments recently?

10. (VITALS13) Next, you want to review your weight history. Where would you find
details? What is your weight goal? When were you overweight? How are you
doing now?

L(VITALS14-15) In talking to your doctor, you realized you feel better on the
“skinny side.” How would you change your goal from 170 pounds to 165 pounds?
12.(EXERO1) Next we're going to think about Exercise. Active Duty personnel are

required to maintain their physical condition, and must take regular "Physical
Readiness Test(s)." The test consists of curl-ups, push-ups, and a 1.5 run (with
substitution options). Persennel are given a score from Failure (less than 45
points) to Maximum (100 points). Based on this, in what area have you most
improved? What area is suffering?

13.(EXER02a) What were the results of your last PRT check-in?
14.(EXER02b) How long before your next PRT?
15.(EXERO0S, 09) What is your PRT goal for the run?
16.(EXER10) You want to challenge yourself by the new year. How do you change

your PRT goal from "passing" to "excellent," which is a time better than 10
minutes, 30 seconds?

17.(EXERD8) Say you hurt your knee while running. How do you switch the PRT run

for a swim?

18.(EXERO0T7) Add a comment to yesterday's workout about your hurt knee.

19. (EXER15) Your doctor has recommended a few exercises for you. What are

they? How are you doing with them?

20.(EXER11) Record that you walked 2 miles in 45 minutes yesterday, and cycled

10 miles for 80 minutes the day before (two days ago)

21.(EXER13) You have a pedometer that generates data about your walks. Import

that into Healthboard, and add a note about the where you walked.

22, (EXER14) What reason did the doctor aive for askina vou to walk? How many

FIGURE 2B: Task Narrative

1

-

FIGURE 2C: Remove Task

Since tasks were organized by importance,
creating context between tasks helps to
“stitch” tasks together for the subject. The
alternative would have been a series of
“cold,” disjointed and unrelated tasks.

When a candidate set of tasks was ready,
PIIM ran a series of 2-4 internal “dry run”
tests with our network of contacts in The
New School University. This exercise allowed
us to refine the test time by eliminating tasks
and tweaking the language to be more
comprehensible. Those participating in the
dry-run tests went through the same protocol
as the subjects.
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Below are the tasks for Group 1 (A and B—task sets were frozen once testing commenced).

TaskID TaskText

GENO3 Please login with the persona you've been provided.
You're being treated with various prescription medications. Your doctor has asked that you use

MEDS02 Healthboard to track your experience with the medications. Where and how would you do this?
Say you just took Warfarin, and it made you feel jittery. How would your record that?

MEDS01 You sometimes take Claritin for your allergies as needed (one 12 hour tablet, 10mg). How would
you report to your Healthboard team that you took it today?

MEDSO05 While looking at your medications, you realize your prescription for Lisinopril has no more refills.
How do you request a renewal?

APPTO1 Next, you'd like to schedule a new appointment regarding your allergies. How would you do that?

APPTO03 You suddenly remember that you have an appointment this coming Wednesday which is in
conflict with another event. How do you cancel the appointment?

MSG01-03 You just remember getting a notification that a Physician had responded to an e-mail you sent
your Healthboard team. How would you go about reading it and replying?

IMMU01-02 You recently sustained a moderate injury from stepping on a nail. When is your next Tetanus
shot? What other vaccinations are due soon?

IMMUO3 When did you have your last Hepatitis A vaccine?

MEDRECO1 You remembered that your doctor suggested some next steps for you — was it a class? How
would you find out? What visit was it related to?

APPTO05 Your doctor recommended a “chair yoga” class. How would you register?

MEDRECO02 How would you mark that Next Step as complete?

MEDRECO03 Where would you find a history of Next Steps?
You just remembered you have an appointment with a new doctor coming up soon regarding

APPTO02, 06 : L
your allergies. When is it?

MEDSO03 You want to show the new doctor a prescription medication you took last year related to the new
appointment. How would you go about finding it? How would you find information on it?

MEDRECO06 ir:l’;ext, you want to show the new provider the results of a past blood test. Where would you find

MEDRECO05 How would you show the provider details about the nasal procedure you had?

MEDRECO07 You want to give your medical record to your new doctor. How would you do that?

MSG04 How would you send a new (urgent) message about Warafin (which is making you feel jittery)?
You sent a message containing a sensitive image to your Healthboard team a few weeks ago,

MSGO05-08 and now you want to delete it. You know it's an e-mail about a “sinus surgery.” How do you go
about finding it, and permanently deleting it?

GENO1 How would you go about changing your password?
Healthboard will e-mail you notifications and reminders, such as when you have any upcoming

GENO04 i : . h
appointment. How would you adjust these notification settings?

GENO05 How would you make all the text on the screen bigger?

GENO06 How would you change the Homepage view of your Healthboard?
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Below are the tasks for Group 2.

TaskID TaskText
GENO03 Please login with the persona you've been provided.
NUTRO1 For the last six months, you've been using Healthboard to maintain a healthy weight through diet
and exercise. Report eating a grilled cheese sandwich with tomato for lunch.
GENO02 Healthboard is in “button view" by default. Please change the “home screen” to “widget view.”
VITALSO1 This morning you weighed yourself: 182 Ibs. Enter that into Healthboard.
VITALS02 How much did you weigh around this time last year?
VITALSO06 You last reported that your weight was 175 Ibs. and temperature 103°. Go back and add a
comment that you “had the flu.”
VITALS10-11 Where would you view other past comments? Has your doctor left any comments recently?
Next, you want to review your weight history. Where would you find details? What is your weight
VITALS13 . -
goal? When were you overweight? How are you doing now?
VITALS14-15 Change your goal from 170 pounds to 165 pounds.
Next we're going to think about Exercise. Active Duty personnel are required to maintain their
physical condition, and must take regular Physical Readiness Tests. The test consists of curl-ups,
EXERO1 push-ups, and a 1.5 mile run. Personnel are given a score from Failure (less than 45 points) to
Maximum (100 points). Based on this, in what area have you most improved? In what area are
you struggling?
EXERO02b How much time until your next PRT?
EXEROS, 09 What is your PRT goal for the run?
EXER10 You want to challenge yourself by the new year. Change your PRT goal from Satisfactory to
Excellent, which is a time less than or equal to 11 minutes 30 seconds.
Your doctor has recommended a few exercises for you. What are they? What reason did the
EXER14, 15 doctor provide? How many calories did you burn on your last exercise? How much weight have
you lost since you started?
Record that you walked 2 miles in 45 minutes yesterday, and cycled 10 miles for 90 minutes the
EXER11
day before (two days ago).
NUTRO7-09 Speaking of calories, tell me about your food plan. What should you be eating? What should you
avoid? What's the reason for this plan? How many calories a day should you have?
NUTR18 How have you been doing on your Food Plan over the last week? Over the last month? Did you
ever exceed your calorie budget? What nutritional recommendations did you fail to follow?
NUTR15 What did you eat for breakfast today? How do you find nutritional information on it?
NUTRO6 Report that you consumed 5 cups of water today.
Healtboard allows you to save frequent meals for quick entry. You eat a peanut butter and jelly
NUTRO4 sandwich for a snack at least once a week, and have saved it. Record you ate a peanut butter
and jelly sandwich for a snack today.
Say you've already entered today’s dinner into Healthboard. It's something you eat frequently.
NUTR16 ; :
Save it for quick entry.
NUTR10 How much sodium should you have daily?
Speaking of sodium, does your most recent blood pressure check indicate any hypertension (aka.
VITALS19 |
high blood pressure)?
You smoke an occasional cigarette, and want to quit. Add a tracker to help you remember how
VITALS20 ) -
much you've been smoking.
NUTR12 You won't always have access to a computer and the internet. Download a worksheet to log your
meals on-the-go.
Where would you find information on the occasional heartburn that some foods cause you?
EDUO3, 06 .
Bookmark it for future reference.
EXERO04 What personal exercises are you doing?
EXER17-18 Add "weight training" as personal exercise. Add "soccer."
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TASK ADMINISTRATION

Upon arrival, subjects are welcomed and

offered refreshment, then provided an

Informed Consent form to sign. They are

also provided a Statement to Subject docu-

ment and a Confidentiality document to

initial (see Appendix 3). Subjects are then

Active Duty in the US Army. She is healthy, taken to the lab, where the Moderator provided

::.::::b?t‘:’;z: syl ::::5 diet, and information and instructions based on the

,Bn:::ur:eu of h:tgdztm::':::w i Moderator Script (Appendix 4). Subjects

izations must be monitared closely. were provided a persona for reference, each

containing a HealthBoard login (FIGURE 3).

Personas are informational only and meant

to provide a reference for test participants.
Once the test began, tasks were read from

FIGURE 3: User Persona a task card (FIGURE 4), told firmly to “begin,”

and the task card was placed in the subject’s

view. Subjects were told to do “the task as

quickly and accurately as possible ... and

not to do anything more than was required

in the task”

When finished with the task, the subject

would announce “done,” and then was

administered a “scorecard” (see FIGURE 5).

Melissa Archeris 22 years old, and on

You're being treated with various prescription medications.
Your doctor has asked that you use Healthboard to track TaSkS. are then rated 01_’1 a scale Of o7
your experience with the medications. Where and how (1 being positive, 7 being negative) for
uld you do this? s .
T T e Complexity, Visual Design, and Overall Appeal.
Say you st took Wenserys, Itz soR Tl Jubery, Once the scorecard is complete, it is

How would your record that?
flipped over and the next task is begun.

After all tasks are complete, the moderator
asks two follow-up questions:

FIGURE 4: Task Card 1. Any general impressions you want
to share before we wrap up?

2. How did you feel about the color
scheme?

Subjects express their thoughts verbally,
which note taker captured for later analysis.
An Exit Survey is then administered, which
the subject completed on SurveyMonkey.com
(see Appendix 5).

FIGURE 5: Task Scorecard

PIIM RESEARCH P I I M © 2013 PARSONS INSTITUTE
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FIGURE 5A: New York Metropolitan Transit Authority
swipe card

Upon departure, subjects were thanked and given an
honorarium of a $10 Metropolitan Transit Authority care
(see FIGURE 5A) in a PIIM enveloped.

FIGURE 5B: The Testing Environment

PIIM RESEARCH
PUBLISHED FEBRUARY 15, 2013
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TEST LOCATION AND ENVIRONMENT
Testing was conducted in p11m’s offices at 68 Fifth Avenue,
Suite 200, New York, NY.

Our Usability Lab (or ULab) was a converted conference
room with seating for the subject, moderator and note-taker
(see FIGURE 5B). The participant’s screen was simulcast
via Morae (usability testing software), and viewable during
the session by an information designer who served as an
error-checker during the exercise. The Moderator intro-
duced and initiated the test, read the tasks aloud, said
“Begin,” then recorded the start and end of each task.

A scorecard was administered after each task.

Last, for later analysis, P11m recorded the screen during
each session. Files were saved to our secure server. No
other audio or video was recorded during the session.

© 2013 PARSONS INSTITUTE
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
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VST P30 [Sapsia) TEST P390 [332k0]

[eree

neenaEonn ¥

5= et

FIGURE 5A: Note Spreadsheet

DATA COLLECTION

Data was gathered with four separate methods: Screener
& Exit Surveys, subject-completed scorecards, analytics
using Morae usability testing software, and notes taken
during session.

SURVEYS

Surveys were used as “book-ends” to the testing. P1IM
screened potential subjects using a Screener Questionnaire
(Appendix 2), administered through the ULab website
after subjects agreed to the study’s Informed Consent
statement. Screener Questionnaire answers were used to
capture name & contact information, determine gender,
age, level of education, first language, self-reported
technical literacy, computer usage, and previous experience
with medical software. See page 44, Screener Survey Results,
for more information about subject demographics.

THE EXIT SURVEY

(Appendix 5) was administered at the very end of the test,
to give the subject an opportunity to express privately their
satisfaction with the software. This survey was mostly
open-ended questions, but key ratings were captured on

a 1 (negative) to 7 (positive) scale regarding: ease of use,
likelihood to use, and likelihood to recommend. See page
156, Exit Survey Results, for more information about exit
survey results.

SCORECARDS
Scorecards (FIGURE 5) were distributed after each tasks.
Subjects rated tasks on a scale of 1 to 7 (1 being positive,

PIIM RESEARCH
PUBLISHED FEBRUARY 15, 2013
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7 being negative) for Complexity, Visual Design, and
Overall Appeal. The aggregate values of each category
are perhaps the most telling information about on which
tasks users had issues of efficiency and effectiveness.

ANALYTICS

Using Morae, the team is able to track metrics such as
Task Duration, Success Rates, Error Count, and steps to
completion (a.k.a. Path Deviation—measured by mouse
clicks and wheel scrolls). p11m has gone to some length

to automate data collection to remove human bias, and
bring our testing effort into general compliance with the
National Institute of Standards and Technology’s (N1ST)
recommendations established in their white paper entitled
Customized Common Industry Format for Electronic Health
Record Usability Testing (Schumacher and Lowry, 2010)
(Appendix 6).

To understand both Time and Path metrics, P1IM
conducted internal benchmarking, the aggregate of which
was assumed to represent a “power user” and, therefore
the optimal time and path for each task. Benchmarking
sessions utilized five staff members of varying familiarity
with the application.

Time and Path comparisons were determined by
dividing the Observed (subjects aggregate measurements)
by the Optimal (benchmark aggregate measurements).

NOTES
The team inputted each group’s notes into a spreadsheet
(see FIGURE 5C).
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Participant Snapshot
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WHAT IS YOUR GENDER?

What is your gender?

24

20

16

12 -

Male Female

Male: 58.3% (14)
Female: 41.7% (10)

WHAT IS YOUR AGE?

What is your age?
24
20
16
12
8
4
i  —
18-24 25-30 31-45 46-55 55-65 65+
Age 18-24: 12.5% (3)
Age 25-30: 4.2% (1)
Age 31-45; 58.3% (14)
Age 46-55: 16.7% (4)
Age 55-65: 4.2% (1)
Age 65+: 4.2% (1)
PUBLISHED FEBRUARY 15, 2013 PIIM FOR INEORATION MARPING
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WHAT IS THE

HIGHEST LEVEL OF EDUCATION THAT YOU HAVE COMPLETED?

What is the highest level of education that you
have completed?

24

20

16

12

0 B B -, ,I,I,_

T T

Less than High School/ Some College 2-Year College 4-Year College  Master's Doctoral
Hhigh School GED Degree Degree (BA, Degree Degree
(Associates) BS)
Less than High School: 4.2% (1)
High School / GED: 4.2% (1)
Some College: 16.7% (4)
2-Year College Degree (Associates): 0.0%(0)
4-Year College Degree (BA, BS): 37.5%(9)
Master’s Degree: 33.3% (8)
Doctoral Degree: 4.2%(1)
PUBLISHED FEBRUARY 15, 2013 PIIM FOR INFORMATION MAPPING
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IS ENGLISH YOUR FIRST LANGUAGE?

Is English your first language?

24

16 -

Yes No

Yes: 83.3% (20)
No: 16.7% (4) “Russian’, “Cantonese’, “Spanish”

PIIM RESEARCH P I I M © 2013 PARSONS INSTITUTE
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

WHAT SOFTWARE APPLICATIONS DO YOU COMMONLY USE AND CONSIDER YOURSELF PROFICIENT WITH
(YOU MAY SELECT MORE THAN ONE)?

What software applications do you commonly
use and consider yourself proficient?

Web browsers (Internet Explorer, Firefox, Chrome)
and e-mail applications (Microsoft Outlook, Google

Office applications (e.g., Microsoft Word, spreadsheet
programs, presentation programs)

graphics, and video

Programming applications, for writing and debugging
code

Creative applications, for things such as music, —

Gaming

Other (please specify)
0 5 10 15 20 25 30

Web browsers (Internet Explorer, Firefox, 100.0% (24)
Chrome) and e-mail applications (Microsoft
Outlook, Google Mail):
Office applications (e.g., Microsoft Word, 95.8% (23)
spreadsheet programs, presentation
programs):
Creative applications, for things such as music, ~ 70.8% (17)
graphics, and video:
Programming applications, for writing and 29.2% (7)
debugging code:
Gaming: 29.2% (7)
Other (please specify) 4.2%(1) “Use a lot of specific programs related to my work “

PIIM RESEARCH P I I M © 2013 PARSONS INSTITUTE
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ON AVERAGE, HOW OFTEN DO YOU USE THE COMPUTER AT SCHOOL / WORK?

On average, how often do you use the computer
at school/work?

Use the computer weekly _

Uesr the computer 2 to 4 times a month

Seldom or never use the computer

0 4 8 12 16 20 24
Use the computer daily: 83.3% (20)
Use the computer weekly: 12.5% (3)

Use the computer 2 to 4 times a month: 0.0% (0)
Seldom or never use the computer: 4.2% (1)

PIIM RESEARCH P I I M © 2013 PARSONS INSTITUTE
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ON AVERAGE, HOW OFTEN DO YOU USE THE COMPUTER AT HOME?

On average, how often do you use the computer
at school/work?

Use the computer weekly _

Uesr the computer 2 to 4 times a month

Seldom or never use the computer F

T

0 4 8 12 16 20 24
Use the computer daily: 87.5% (21)
Use the computer weekly: 12.5% (3)

Use the computer 2 to 4 times a month: 0.0% (0)
Seldom or never use the computer: 0.0% (0)

PIIM RESEARCH P I I M © 2013 PARSONS INSTITUTE
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DO YOU PRESENTLY OR HAVE YOU EVER USED ANY SOFTWARE PACKAGES TO
TRACK HEALTH-RELATED INFORMATION?

Do you presently or have ever used any software
packages to track health-related information?

24

20

16

12

Yes No

Yes: 4.2% (1)

No: 95.8% (23)

PIIM RESEARCH P I I M © 2013 PARSONS INSTITUTE
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Results e» Recommendations

EVALUATION METHOD

PIIM came to these conclusions and recommendations by
reviewing the data collected, reviewing the notes, watching
the playback of each task (at 2x speed), and finally reading
the exit surveys.

GROUP A USABILITY SCALE

1. No Issue means the functionality covered in the
task is highly usable.

2. Minimal Issues means there is functionality that
could use improvement, but it is still usable. Stated
recommendations are generally based on observation
of research team.

3. Minor Issues means functionality exists which
is impairing usability, but tasks are still completed
successfully. Stated recommendations sometimes
are based on observation of research team, and
occasionally on data.

4. Moderate Issues describes functionality that is
partially impairing the user’s ability to successfully
complete tasks. Stated recommendations are generally

THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

based on data collected, and occasionally on obser-
vation of the research team.

5. Severe Issues describes functionality that is
definitely impairing the user’s ability to successfully
complete tasks. Stated recommendations are based
on data collected.

ATTEMPTED FIXES

Fixes were the result of collaboration between Design,
Development and Usability Leads. Usability Lead makes
a series of recommendations based on testing. Recom-
mendations were then prioritized and estimated (level
of effort for Design and Development), then accepted
or rejected (See FIGURE 5D). On occasion, alternative
solutions were worked out during the sessions and
implemented. For more information, see Appendix 7:
P1A Review.

GROUP B USABILITY SCALE

1. Improved means p1im’s attempted fix success-
Sfully improved the application across multiple cat-
egories (e.g., scorecard results, successful completion,
time, path or error reduction).

2. Indeterminate means the success of PIIM s
attempted fix is not able to be determined due
to lack of data, conflicting data or an absence
of observational anecdotes.

3. Revert or Revise means pI1IM’s attempted fix
negatively improved the application across
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AGGREGATE SUCCESS RATE

Below are the aggregate success rates per module. These
are calculated first by averaging Groups A and B, then by
taking the mean success of all tasks for a given module.

Module

MEDS 70.83
EXER 70.83
MmsG 77.78
VITALS 80.21
MEDREC 81.94
NUTR 86.11
APPT 95.83
IMMU 95.83
Median 81.07
N PLIM [ i
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

Group 1 Task: Task Analysis

o Setting

o Medications

o Appointments
o Messages

e Immunizations

o Medical Records

PIIM RESEARCH P I I M © 2013 PARSONS INSTITUTE
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GENO3
Please login with the persona you've been
provided.

GROUP A DETERMINATION:
No Issues

PIIM RESEARCH
PUBLISHED FEBRUARY 15, 2013
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GENO03: Mean Scorecard Return,
Group Avs. B

i Task Complexity & Visual Design  Overall Appeal

6.0
4.0
17 20
2.0 T0 1z T.0 Iz
o/ NN BN
Group A Group B
Mean Success Observed Time:
GENO3 Benchmark Time
GENO3
120
100 - 3.00
80 - 2.50
2.00
60 -
1.50 -
40 1.00 -
20 - 0.50 -
0 - 0.00 -

Group A Group B Group A Group B
Observed Path: Mean Number of
Benchmark Path Errors

GENO3 GENO3
6.00 1
5.00 0.8
4.00 06
3.00
2.00 - 0.4
1.00 -E 0'2
0.00 - 0 T )
Group A Group B Group A Group B
P I I M © 2013 PARSONS INSTITUTE
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MEDS02
You're being treated with various prescription MEDSO02: Mean Scorecard Return

medications. Your doctor has asked that you ’
use HealthBoard to track your experience Group Avs. B
with the medications. Where and how would
you do this? Say you just took Warfarin, and W Task Complexity ™ Visual Design Overall Appeal
it made you feel jittery. How would your

record that?
6.0
GROUP A DETERMINATION: 3.8
Severe Issues 4.0 30 3335 35
2.5
o Task Complexity: 3.8 (2nd worst) 20 —
o Overall Appeal: 3.0 (Tied, 3rd worst) 00 -
A B
o Successful Completion: Group Group
66% (4th worst)
o Error Rate: 0.33 (2nd worst)
« Problem with testers not understanding Mean Success Observed T'r'ne:
the “blue highlight” MEDS02 Benchmark Time
MEDS02
120
GROUP B VALIDATION:
3.00
Improved 100
80 2.50
o Successful Completion: 60 2.00
25% increase, from 66% to 83% 1.50 -
_ 40 1.00 -
o Observed Time: 20 050 -
Benchmark: 15% decrease,
from 1.82 to 1.55 0 0.00 -
Group A GroupB Group A GroupB
o Observed Path:
Benchmark: 37% decrease,
from 2.27 to 1.42 Observed Path: Mean Number of
Benchmark Path Errors
o Number of Errors: MEDS02 MEDS02
48% decrease, from 0.33 to 0.17
6.00 1
RECOMMENDATION 5.00 0.8
. 4.00
« The changes were successful, showing 0.6
an increased completion rate, less 3.00 0.4
time, fewer clicks, and less error. 2.00 ’
1.00 0.2 1
o Consider further simplifying or refine 0.00 - 0 -
the visual design. Group A Group B Group A  Group B
PUBLISHED FEBRUARY 15, 2013 PIIM FOR INFORMATION MAPPING

[PAGE 56]



THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

ATTEMPTED FIXES
1. Display the “take medication” nodes as something similar to checkboxes.

ano Visual Dashboard Prototype /{ updated 26sep2012

Isaac Goodman  Logout §}

Medications v You have 2 medications you need to refill now or soon. _ﬂ

pyoT— st TimeRange: tw 1m 3m 1y 3 Al cusors [H[EED Alerges

Medication Name Date
Prescription Drugs

Lisinopril (Prinivil/Zestrl) [} Conditions

HCTZ (Esidrex/Oretic) {0} Hypertension
- High cholesterol

Pharmacy Alert

Acetaminoph
Renewal Reminders

Supplements
~ Request renewal for Lisinapril
+ Raquest renewal for Coumadin®

Herbal Medicines

Jiang Ya Pian

Wed, Jun 13 Thu, Jun 14 Fri, Jun 15 Sat, Jun 16 Sun, Jun 17 Mon, Jun 18 Tue, Jun 19

[ Scheduled Asneeded | Overdosejunderdose
[ Mot Taken

‘One error in opening the page. For more information. choose Window > Activity. A

FIGURE 9A: Before

TATRC2_GUI_madications_01.0_timelineview_SettingsLogout.al

Available  IsascGoodman  Settings  Logout

Medications ~ You have 2 medication: 3 _ﬂ

Learn more about Medication:

Medication Name Today ~Your renewal request for HCTZ
(Esldrex/Oretic) PO 25mg Tab
Prescription Drugs rp——

Lisinopril (Prinivil/Zestril)

T Allergies

HCTZ (Esldrex/Oretic) - Aspirin

PO25mgTab ] ~Latex (Do Not Use, Not Screened)
~Natural Rubber (Do Not Use, Not

‘Warfarin (Coumas ) Screened)

PO Smg Tab

Over-The-Courer Drugs Conditions

- . *Hypertension

‘Acetaminophen (Tylenol® PM) e ket

Supplements
i Pharmacy Alart

Farr ifate

PO 325mgTab

Lipodrene 10} Renewal Reminders

Herbal Medicines ~Request renewal for Lisinapril
~Request renewal for Coumadin®

Jiang Ya Plam N BN EEE BEEE
+ Request Renewal
Sun, June 15 Mon, June 16 Tue, June 17 Wed, June 18 Thu, June 19 Fil, June 20 Sat, June 21

Scheduled ¥ NotTaken L. overdosefunderdase

FIGURE 9B: Affer
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ATTEMPTED FIXES (CONTINUED)
2. Remove the irrelevant “Date” label, add Today above the “blue column.”

Visual Dashboard Prototype /{ updated 26sep2012

Isaac Goodman

Logout £}

Medications v

You have 2 medications you need to refill now or soon.

T

Medication Name

st Timetange: 1w 1m 3m 1y 3 Al cotorn [EE]

Allergies
Date

Prescription Drugs

Lisinopril (Prinivil/Zestrl) [}

HCTZ (Esidrex/Oretic)

Conditions

Hypertension

« High cholesterol

Pharmacy Alert

Acetaminoph
Renewal Reminders
Supplements
~ Request renewal for Lisinapril
+ Raquest renewal for Coumadin®

Lipodrene
Herbal Medicines

Jiang Ya Pian

Wed, Jun 13 Thu, Jun 14 Fri, Jun 15 Sat, Jun 16 Sun, Jun 17 Mon, Jun 18 Tue, Jun 19

[ Scheduled Bsneeded |
[ Mot Taken

Overdosejunderdose

‘One error in opening the page. For more information. choose Window > Activity. A

FIGURE 10A: Before

TATRC2_GUI_madications_01.0_timelineview_SettingsLogout.al

Available  IsascGoodman  Settings  Logout

Medications ~

You have 2 medication:
Learn mare about Medication:

Medication History ‘

TimeRange: 1w 1m 3m 1y 3y Al Custom Updates

Medication Nama

~Your renewal request for HCTZ
(Eshdrex/Oretic) PO 25mg Tab
was approved

Today
Prescription Drugs

Lisinopril (Prinivil/Zestril)

T Allergies

~Aspidn

~Latex (Do Not Use; Not Screened)

~MNatural Rubber (Do Not Use, Nat
Screened)

HCTZ (Esldrex/Oretic)
PO 25mgTab

‘Warfarin (Coumay
PO Smg Tab
Over:Tha-Courter Drugs Conditions
*Hypertensis
Acetaminophen (Tylenol* PM) ke

Supplements
i Pharmacy Alart

Farmous Sulfata
PO 325mgTab
Uipodrene

Renewal Reminders

Herbal Medicines ~Request renewal for Lisinopril

~Request renewal for Coumadin®

+Request Renewal

Jiang Ya Plam

N BN EEE BEEE

Sun, june 15 Mon, June 16 Tue, June 17 Wed, June 18

Scheduled ¥ NotTaken

Thu, June 19 F, June 20 Sat, June 21

L. overdose/underdose

FIGURE 10B: After

PIIM RESEARCH
PUBLISHED FEBRUARY 15, 2013
[PAGE 58]

© 2013 PARSONS INSTITUTE
FOR INFORMATION MAPPING

PIIM



THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

ATTEMPTED FIXES (CONTINUED)
3. On specific Medications, add a Record Intake button.

ano Visual Dashboard Prototype /{ updated 275ep2012

IssacGoodman  Logout b

Medications v You have 2 medications you need to refill now or soon. _ﬂ

[ Medication History | | Warfarin (Coumadin®)-POSmgTab X |

Aedication Details Refills and Renewals History

= G
Pt {Exexipe YN Gnw e ocolely o3 T S i Refill#  DateFilled Prescription#  Quantity  DaysSupply  Pharmacy

Drugimage | e 1 March 20,2011 NBOgE765+4 0 Not recorded Walgreens

2 Apil23,2011 NB1234567 Not recorded Building 9 Pharmacy

Intake History
Status  Active

Date and Time Comments

Prescription # 6166937

Quantity 30 2012 12:00:00 PM
Sig. / Directions Take one every day

Expanded Sig. Take with a big glass of water
Intake time 0900 (Moming) 06/12/2012 120000 P

06/14/2012 12:00:00 PM

Reasonwhy To treat high blood pressure 06/13/2012 120000 AW
ou are taki (hypertension)
4 i 06/12/2012 120000 AM
Sida Effects Alergic reaction, fainting flu symptoms, | 02112012 120000 AW
chest pain, and weight gain

Exile lalt/ 0015 Pharmacy Comments
Lastfilled date  May8, 2012 24

Provider Dr. Gregirt Berg, Team 1 . _
Dr. Gregory Berg June 15,2011 a1 Bid5pm
Pharmacy Pharmacy
Phone (202) 685-3100
Address 103 3rd Ave, SW
Washington, DC 20319
Show All Pharmacies

Ut enim ad minim veniam, quis nostrud exercitation ullamce laboris nisi ut aliquip ex
£a comoconsequat. Duis aute irure dolor in reprehenderit in voluptate velit esse cillum
dolore eu fugiat nulla pariatur,

FIGURE 11A: Before

8nn Visual Dashboard Prototype // updated 13n0v2012

Healthboard You have 3 Next Steps ¥ Isaac Goodman  Settings  Logout

il Medications v You have 2 medications you need to refill now or soon. _ﬂ

M.ﬁuliuIIHinol'll Warfarin (Coumadin®)-PO5mgTab X
T e

Medication D¢ . 's

Record Intake
.- 4
Name /Dosage Warfarin (Coumadin®) - PO 5mg Tal [— P harTa

Drugimage [§ trecorded Walgreens

trecorded Bullding 9 Pharmacy.
Name: Warfarin (Coumnadin®)

Intake:  Dosage Quantity

Acth -
R [ 15t dosage [E’ tabletts)

6166937 [ more than 1
30

Take one every day
Take with a big glass of water
Intake time 0900 (Moming}

Comments:

Reason why To treat high blood pressure
you aretaking {hypertension)

Side Effects  Alergic reaction, fainting, flu symp1
chest pain, and welght gain

Refillsleft 00f3
Lastfilled date May8,2012

Provider Dr. Gregirt Berg, Team 1 i .
Dr. Gregory Berg June 15,2001 st B:45pm
Pharmacy
(202) 685-3100
103 3rd Ave, SW
‘Washington, DC 20319
Show All Pharmacies

Ut enim ad minim veniam, quis nestrud exercitation ullamco laboris nisi ut aliquip ex
€3 comoconsequat, Duis aute irure dolor in reprehenderit in voluptate velit esse dillum
dolore eufugiat nulla pariatur.

)
FIGURE 11B: After
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

MEDSO01
You sometimes take Claritin for your allergies MEDSO1: Mean Scorecard Return

as needed (one 12 hour tablet, 10mg). How ’ G A B !
would you report to your HealthBoard team roup A vs.

that you took it today?
i Task Complexity & Visual Design Overall Appeal

GROUP A DETERMINATION:

Severe Issues
6.0
o Successful Completion: 16.6% (Worst)
4.0
o Error Rate: 0.67 (Worst) 22 23 23 30 25 Y
o Testers do not see the “as needed” 2.0 ‘
option, or understand its meaning.
0.0 -
« Testers do not record intake after Group A Group B
adding the medication.
GROUP B VALIDATION:
Improved
 Successful Completion: Mean Success Observed Tlr'ne:
100% increase, from 16% to 33% MEDS01 Benchmark Time
120 MEDSO1
« Observed Path:
Benchmark: 44% decrease, 100 3.00
from 1.90 to 1.07 2.50
80
2.00
« Number of Errors: 60 1.50
24% increase, from 0.67 to 0.83. 40 '
1.00 A
o In group 1B, two errors were caused 20 - 0.50 -
by participants selecting the wrong 0 - 0.00 -
medication, either by misspelling GroupA Group B GroupA Group B
it (e.g. “Claretin”) or choosing
incorrectly from the “autocomplete”
interaction. Two other errors were a
task oversight, where the testers forgot Observed Path: Mean Number of
:zlfeh;:g (ﬁl; Z}fjéﬁglsxmedlcauon was Benchmark Path Errors
’ MEDSO01 MEDSO01
RECOMMENDATION 6.00 1
o The changes were successful, show- 5.00 0.8 -
ing an increased completion rate and 4.00 06 -
fewer clicks. 3.00 )
200 947
« Insisting users verify the medication ’ 02 -
name may reduce error. 1.00 1 ‘
0.00 - 0 -
o Force a selection of “Yes, this medica- Group A Group B Group A Group B
tion was taken today,” perhaps using

Yes and No radio buttons.

PIIM RESEARCH P I I M © 2013 PARSONS INSTITUTE
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

ATTEMPTED FIXES
1. Remove default option for Frequency, if user doesn’t selection, pop get error message.
2. Add checkbox: “Yes, this medication was taken today”

YaYe) Visual Dashboard Prototype // updated 27sep2012

lsaacGoodman  Logout b

Medications v You have 2 medications you need to refill now or soon. _ﬂ

pyoTT— S Tinefange: 1 1m 31y 35 al_custor I[EE] Alergies

Add Medication S Aspeiny
+ Latex (Do Not Use, Nat Screened)
Type: OverThe-Counter Drugs *Natural Rubber (Do Not Use, Not
Prescription Drugs Sereened)

Name: | PANWARFIN
Lisinopril (Prinvil/Zestril) |
Dosage (PO): |:| ma
HCTZ (Esidrex/Oreticl
" warmey: Take [1 [ tablets forsach intake
Warfari madin®) S
= Pharmacy Alert
Over-The-Counter Drugs Frequency: @ / ﬂ

W O horeesd
Acstaminophen (Tylenal...

Sig/Directions: +Take one every 4 - 6 hours while symptoms persist.
+ Do not exceed 6 tablets in 24 hours unless directed by a doctor.

Medication Name Date

Conditions

Renewal Reminders
Supplements

- Request renewal for Lisinopril
Reason for Taking: + Request renewal for Coumadin®

Sulfate

Herbal Medicines

Jiang Ya Pian e

Wed, Jun 13 i

[ Scheduled (@ Asneeded | Overdose/underdose
[ Mot Taken

One error in opening the page. For more information. choose Window > Activity. “%

FIGURE 14A: Before

(] “TATRCZ_GUI_madications_15_addmedication_6.02.ai

Healthboard Avallable  lsaacGoodman  Settings  Logout

Medications ~ You have 2 medications you need to refill now or soon.
Learn mare about Medication: Educarional Resources

Medication History
PrP— T P Teatarge: 1w tm 5 1y 3y M Cotam

TSRS TN S  Add Medication ~Your renewsl request for HCTZ
(Esldrex/Oretic) PO 25mg Tab

Uisinoprl Print )-PO40mg T Type: | Over-The-Counter wes appraved

HCTZ (Esidrex/ )~ PO 25mg Tab "

(Esidrex mg Ta Name: | Tbuprofen (Advit Allergies
srfarin (Coumadin®) - PO 5mg Tab
Dosage (PO): | 200 | mg - Aspirin
Acetaminophen (Tylenol® PM) = Latex (Do Not Use, Not Screanad)
*Natural Rubber (Do Not Use, Not

5 1 | GBetsfor X
Quantity: Take + tablets for each intake Sy

Fermous Sulfate - PO 325mg Tab

ipmxiene A\ Frequency: O Regularschedule

Conditions
Jlang Ya Plan Please enter frequency () Asneeded

~Hypertension
Sig/ Directions: + Take one every 4 - 6 hours while symptoms persist ~High cholesterol
« Do not exceed 6 tablets in 24 hours unless directed by a doctor.
Pharmacy Alert
Reason for Taking: | Headache

Renewal Reminders

=Request renewal for Lisinapril
Was it taken today?: (| Yes, this medication was taken today. S ke S st

Cancel +Request Renewal

FIGURE 14B: After. Error shown if no option for Frequency is selected.
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PIHMRES[EARCH

MEDSO05

While looking at your medications, you realize
your prescription for Lisinopril has no more
refills. How do you request a renewal?

GROUP A DETERMINATION
No Issues

PIIM RESEARCH
PUBLISHED FEBRUARY 15, 2013
[PAGE 62]

THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

MEDSO05: Mean Scorecard Return,
Group Avs. B

i Task Complexity & Visual Design  Overall Appeal

6.0
4.0 30
20 2.5
1.7 1.7 :
2.0 1.5 I
0.0 -LL
Group A Group B
Mean Success Observed Time:
MEDSOQ5 Benchmark Time
MEDSO5
120
100 - 3.00
80 - 2.50
2.00 -
60 -
1.50 -
40 1.00 -
20 0.50 -
0 - 0.00 -

Group A GroupB Group A GroupB
Observed Path: Mean Number of
Benchmark Path Errors

MEDS05 MEDS05
6.00 1
5.00 0.8
4.00 06
3.00
2.00 0.4
in = OEEEN BN
0.00 - 0 -

Group A Group B Group A Group B
P I I M © 2013 PARSONS INSTITUTE
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

APPTO1

Next, Youd like to sch.edule a new appointment APPTO1: Mean Scorecard Return,
regarding your allergies. How would you do

that? Group Avs. B

GROUP A DETERMINATION: & Task Complexity & Visual DeSign Overall Appeal
Moderate Issues

o Visual Design: 3.2 (3rd Worst) 6.0

o Approx. half the testers were confused 4.0 58 32 32—37
by the “common reasons for visit” 2.2 2.5
area and the “browse full list text;” 20 S —
we're not sure if this is something they
should use or not. 00 -

A B

« For some, it took a second to realize Group Group
they needed to click the orange box to
make the appointment.

o Nearly all expected some sort of con- .
firmation message following clicking Mean Success Observed T""ne'
the orange box, like “Your appoint- APPTO1 Benchmark Time
ment has been scheduled” 120 APPTO1

. 3.00
GROUP B VALIDATION: 100
Improved 80 - 2.50
€0 2.00
o Due to the confirmation message, 1.50 -
PIIM’s team observed that users had 40 A 1.00 -
no cqnfusion a.fter confirming an 20 - 050 -
appointment time.
0 - 0.00 -
Group A GroupB Group A GroupB
Observed Path: Mean Number of
Benchmark Path Errors
APPTO1 APPTO1
6.00 1
5.00 0.8
4.00 0.6
3.00
2.00 0.4
0.00 - 0 T \
Group A Group B Group A Group B
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

ATTEMPTED FIXES
Add confirmation message after appointment is made.

YaYe) Visual Dashboard Prototype /f updated 275ep2012

IsaacGoodman  Logout §}
Appointments v You have 5 appointments in the coming week. seare cppommens — [iGH

Upcoming T [ EEE EventDetals

B ifevy - Propmicl Earmation: 30 Sun 1 Mon 2 Tue 3 ssn O Dr.Berg
Wed, Oct3, 1100 hrs SR -
0600 From Oct4,20123t 1030
Dr. Graenfield - Allergies
Fri, Oct 5, 09:30 hrs

Type Routine
Dr. Berg - Flu Vaccination Classific. Outpatient

Thu, Oct 11, 1130 hrs
0700

Dr. Berg - Physi i 9 M

99 Main
Thu, Oct 4, 10:30 hrs New York, NY 11111

Message Dr. Berg

Recommended

Tetanus Vaccination - Cancel Appointment
Schecuie Appointment

Gentla Chai
Schecul

October 2012 »

M TWTEFS
zn45 6
011 12 13

6 17 18 19 20
24 25 26 27

Ell

One error in opening the page. For more information, choose Window > Activity. %

FIGURE 17A: (Before) Shows a recently added appointment.

C2_GUI_appointments_04.4_CONFIRMATION..ai
Avallable  lsaacGoodman v Help ¥

Appomtments ¥ Your appointment request have been sent.
Upcoming +Requestan Appaintment | +Find a Class Event Details

e Ko 5 Ol ack Be 2011 sunNov1s  Mon,Novi6  TueMNovi?  WedNovi8  ThuNov1d  FriNov20  SatNov2l Tk apclntaiet b3 oo g i
Mon, Nov 16,0830 s <

Dr. Hammond - Physical Exa. 0500 Physician T8O, Team 1

Mon, Nov 16,1145 hrs | From Nov 20,2011 2t07:15
| To Nov20, 201120745

Routine
Classification Outpatient
RFV PapSmear

Next Steps

Tetanus Vaccination

il i Phone (999)995.9999

Gentle Chair Yoga | | 1 | Address The New York Clinic
I 99MainSE.

New York NY 11111

Schedule Class

Message Team 1

- Caneel Request

November 2011
SMTWTES
123 456 7
B 910 11 1213 14
sl 18 1920 20
2 232425 2627 28
29 30

FIGURE 17B: Aftfer
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PIHMRES[EARCH

APPTO3

You suddenly remember that you have an
appointment this coming Wednesday, which
is in conflict with another event. How do you
cancel the appointment?

GROUP A DETERMINATION:
No issues

o Some users tried clicking on the ap-
pointments in the left column. These
are disable for prototyping reason, but
in the future these should be available.

PIIM RESEARCH
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:

USABILITY TESTING RESULTS

APPTO03: Mean Scorecard Return,
Group Avs. B

i Task Complexity & Visual Design  Overall Appeal

6.0
4.0 5 s
23 202 2.3 .
2.0 1.7
0.0 -
Group A Group B
Mean Success Observed Time:
APPTO3 Benchmark Time
APPTO3
120
100 - 3.00
80 - 2.50
2.00
60 -
1.50 -
40 7 1.00 -
20 7 0.50 -
0 - 0.00 -

Group A Group B

Group A Group B

6.00
5.00
4.00
3.00
2.00
1.00
0.00

Observed Path:

Benchmark Path
APPTO3

=

Group A Group B

Mean Number of

Errors
APPTO3
1
0.8
0.6
0.4
0.2
NN

Group A Group B

PIIM
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

MSG01-03
You just remember getting a notification that MSGO01-03: Mean Scorecard Return

a Physician had responded to an e-mail you ’
sent your HealthBoard team. How would you Group Avs. B
go about reading it and replying? . _ _
K Task Complexity ¥ Visual Design Overall Appeal
GROUP A DETERMINATION:

Minimal Issues
6.0
o Users appear to be confused for a
second after replying to a message. 4.0
20 20 1.8 1.8 2.2
GROUP B VALIDATION: 20 1.5
Improved - -
0.0 -

o Observed Time: Groun A Grouo B
Benchmark: 32% decrease, from 2.14 P P
to 1.47. User noticed the confirmation
message, would confidently announce
“Done” at the end of the task.

« Observed Path: Mean Success Observed Time :
Benchmark: 42% decrease, from MSG01-03 Benchmark Time
1.90 to 1.11. Previously users would 120 MSGO01-03
browse inboxes or scroll for “sent” 3.00
verification. 100 - 2'50

80 :
2.00 A
60 -
1.50 -
40 7 1.00 -
20 7 0.50 -
0 - 0.00 -

Group A Group B Group A Group B
Observed Path: Mean Number of
Benchmark Path Errors

MSG01-03 MSGO01-03

6.00 1

5.00 0.8

4.00 0.6

3.00

0 ™ E— 04

0.00 - 0 T )

Group A Group B Group A Group B
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

ATTEMPTED FIXES
Add a “message sent” success confirmation.

YaYe) Visual Dashboard Prototype /f updated 27sep2012

lsaacGoodman  Logout b

Messages v You have 1 new messages. _ﬂ

MAILBOXES

Chronic pain
Between You and a Nurse

@ nurse August 22, 2011

Ut enim ad minim veniam, quis nostrud exercitation ullamco laboris nisi ut aliquip...

You August 22, 2011

Reply number 1...

Nurse August 22,2011

3rd messageesees

You

this is my reply

Add attachment

‘One efror in opening the page. For more information. choose Window > Activity. 4

FIGURE 18A: (Before) Sent message just appears on the bottom of the thread.

(] TATRC2_GUI_message_01.6_CONFIRMATION.ai

Healtht C Available Isaac Goodman ¥  Help

MAILBOXES
Inbox

Drafts Chronic pain

Sent Between You and a Physidan

Trash @ Fhysician Tadiay at 345 PM
Ut enim ad minim veniam, quis nostrud exercitation ullamco laboris nisi ut aliquip ex
ea Duis aute irure dolor in it in veluptate velit esse cillum
dolore eu fugiat nulla pariatur.

You Todiay at 3:55 PH

Ut enim ad minim veniam, quis nostrud exercitation ullameo laboris nisi ut aliquip ex 2attachments — View All Download All

ea comoconsequat. Duis aute irure dolor in reprehenderit in voluptate velit esse cillum
dolore eu fugiat nulla pariatur, m imagefilejpg (2MB) View Download

nanimagefile.doc (138KB) View Download

Click here to Reply. Replay 1o all, or Forward

Add attachment

FIGURE 18B: Affer
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PIHMRES[EARCH

IMMUO1-02

You recently sustained a moderate injury
from stepping on a nail. When is your next
Tetanus shot? What other vaccinations are
due soon?

GROUP A DETERMINATION:
Minor Issues

o Task Complexity: 3.2 (4rd Worst)

« Visual Design: 3.0 (4th Worst)

o Overall Appeal: 3.0 (Tied 3rd Worst)
o Successful Completion: 83.3%

o Observed Path:
Benchmark: 2.95 (5th Worst)

o Error Rate: 0.17

» Most testers had difficulty finding
Tetanus (labeled “Td/Tdap”).

GROUP B VALIDATION:
Improved

o Successful Completion:
20% increase, from 83% to 100%

o Observed Path:
Benchmark: 22% decrease, from 2.95
to 2.29 indicating testers were more
confident in their answers.

« Error Rate: 0, decrease from 0.17
RECOMMENDATIONS
o Keeping medical terminology and

shorthand to a minimum will improve
ease of use.

PIIM RESEARCH
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:

USABILITY TESTING RESULTS

IMMUO1-02: Mean Scorecard Return,
Group Avs. B

i Task Complexity & Visual Design Overall Appeal

6.0
o n 3.5
4.0 3230 30 30 2.8
2.0
0.0 +
Group A Group B
Mean Success Observed Time:
IMMUO01-02 Benchmark Time
IMMUO01-02
120
100 3.00
20 2.50
2.00
60
1.50 -
40 1.00 -
20 0.50 -
0 0.00 -

Group A Group B

Group A Group B

6.00
5.00
4.00
3.00
2.00
1.00
0.00

Observed Path:

Benchmark Path
IMMUO01-02

Group A Group B

Mean Number of

Errors
IMMUO01-02

0.8

0.6

0.4

0.2

0 -

B

Group A Group B
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

ATTEMPTED FIXES
1. Change “Td/Tdap” to Tetanus-diphtheria.
2. Add Today to date bar for consistency with other modules.

YaYe) Visual Dashboard Prototype // updated 27sep2012

Healthbcarc baacGoodman  Logout £}

Immunizations v You have 12 immunizations due or due soon. _m

Learn more about Immunizati o
Immunization Histary

view: [THEY TmeRange: 1m 3m 1y 3y Sy 10y Al Custom [ Allergies

atex (Do Not Use, Not Screened)
: - Natural Rubber (Do Not Use, Not
] f—)

Immunization

Hepatitis A
Exemption
Hepatitis B

Influenza

Td/Tdap
Typhold
ila
Vellow Fever
Jan12 Feb12 Mar12 Apri2 May 12 Juni2 Juliz Aug1z sep12 Oct12 Nov12 Dec12

Due @ Duewithin1month Addressad Today for Immunizations Have BeenGiven @ Completed

One error in opening the page. For more information. choose Window > Activity. %

FIGURE 23A: Before

TATRCZ_GUI immunizations_1.1_t_lyr.al

Avallable  lsaacGoodman v Help  fF

Immunizations ~ You have 4 immunizations due or due soon. _ﬂ

Learn more about Immunization: £

T —

View: M TimeRange: 1m 3m 1y 3y Sy 10y All Custom Allargles

Immunization Today e Fs
+Latex (Do Not Use, Not Screened)
Anthrax - Natural Rubber (Do Not Use, Not
Screened)
Hepatitis A
HepatltisB Exemption
Influenza
Japanese encephalitis
Measeles
Meningococcal
Mumps
Poliovirus
Rables
Rubella
Smallpex
Tetanus-diphtheria
Typhold
Varicell

Yellow Fever .

Ol Novl0  Decl0  Janit'  Feb11'  Maril’  Aprit'  Mayi?'  Junit’  Jul1l'  Augit’  Sepil’  Oair

Due @ Due within 1 month Addressed Today for Immunizations Have Been Given @ Completed

FIGURE 23B: Affer
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

IMMUO3
Whe'n did you have your last Hepatitis A IMMUO3: Mean Scorecard Return,
vaccine?
Group Avs. B
GROUP A DETERMINATION:
No issues i Task Complexity & Visual Design = Overall Appeal
GROUP B NOTE
6.0
o Observed Path:
Benchmark: 664% increase, from 0.48 4.0
to 3.67. Mouse “wheel scrolling” is 20 20 138 23 25
included in the Path metric. Occasion- 20 ; 17 I—
ally, a “heavy scroller” will come along
which can create false positives; this is 00 -
the case here. Tester P1B-08 had the ’
Group A Group B
heavy hand.
Mean Success Observed Time:
IMMUO3 Benchmark Time
IMMUO3
120
100 - 3.00
20 1 2.50
2.00
60 -
1.50 -
40 1 1.00 -
20 0.50 -
0 - 0.00 -
Group A GroupB Group A GroupB
Observed Path: Mean Number of
Benchmark Path Errors
IMMUO3 IMMUO3
6.00 1
5.00 0.8
4.00 0.6
3.00 -
2.00 A 0.4
1.00 - 0.2
0.00 - 0 T )
Group A Group B Group A Group B
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

MEDRECO1
You remembered that your doctor suggested MEDRECO1: Mean Scorecard Return
some next steps for you—was it a class? How ’
would you find out? What visit was it related Group Avs. B
to?

K Task Complexity & Visual Design  Overall Appeal
GROUP A DETERMINATION:
Moderate Issues 58 57

o Task Complexity: 3.3 (Tied 3rd Worst)

o Successful Completion: 83.3%

o Observed Path:
Benchmark: 3.09

r A r B
o All participants had difficulty locating Group Group
Next Steps.
« In Appointments, “Next Steps” are
called “Recommendations” X
Mean Success Observed Time:
« Testers had trouble locating the related MEDRECOL Benchmark Time
visit MEDRECO1
: 120
3.00
GROUP B VALIDATION: 100
Revert or Revise 80 2.50
2.00 A
. 60
 Task Complexity: 1.50 -
75% increase, from 3.3 to 5.8 40 1.00 -
20 0.50 -
o Visual Design:
127% increase, from 2.5 to 5.7 0 0.00 -
Group A GroupB Group A GroupB
o Overall Appeal:
63% increase, from 2.7 to 4.3
_ Observed Path: Mean Number of
: S“(fce“ful Completion: Benchmark Path Errors
60% decrease, from 83.33 to 33.33 MEDRECO1 MEDRECO1
o Error Rate: 0.67, up from 0 6.00 1
5.00 0.8
o Without question, P1IM positioned 4.00
the Next Steps block in a “blind spot” ' 0.6
of the ur. Most users failed to find the 3.00 7 0.4 -
call-to-action, despite it being omni- 2.00
present in the interface. 1.00 - 0.2 1
0.00 - 0 -
Group A Group B Group A Group B
PIIM RESEARCH ©2013 PARSONS INSTITUTE
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

RECOMMENDATIONS

» Continue working on the display to
Next Steps, but use formative test to
determine the block’s visibility.

o Next Steps should be the initial block
every user sees after signing into
HealthBoard. Perhaps this can be
accomplished with U1 similar to the
Health Focus block within Health-
Board’s Provider portal.

o Survey whether Next Steps is the
appropriate vocabulary.
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

PIIMR[ESEARCH

ATTEMPTED FIXES
1. Have a block or section solely for patient's next steps, located at the top (similar to Health Focus in the Provider Portal).
Also include a link to the original visit.

Visual Dashboard Prototype // updated 27sep2012

Isaac Goodman

Medical Records v You have 1 new medical record.

Type of Service | Date
Visits
PCP
Specialist
=
Diagnostic Studies
Radiology
Labs
Clinical Tests
Surgeries
Procadures
Decto a1 Feb11 Marn Aw,“ May'n Jun1n i A“g,“

[l OutpatentServices () Inpatient Services

Total Service Usage My Next Steps History

- Startthe Physical Rehabilitation regimen we spoke about. Our Gentle Chalr Yoga Mark completed

8 Outpatient Services

4

inthe past year

Diagnostic Services
inthe past year

class would be beneficial if you find the time.
Recommendation: Gentle Chair Yoga Class

* Continue to check blood sugar twice daily.

Recommendation: Set a Reminder

Remove

Mark completed

Rem

One error in opening the page. For more information. choose Window > Activity. “%

FIGURE 27A: Before

TATRCZ_GUI_Home002_login_next_steps_4.ai

You have 3 Next Steps & Available Settings

History
Urgency v | Assigned On
4/16/2011
4162011

31202011

Next Steps Assignes
Dr. Berg
Dr. Berg

Dr. Berg

Status
Gentle Chair Yoga Class Complete
Seta reminder In progress

Exercise for 40 minutes a day with running. In progress

Vital Signs

e
-

“—

Educational Medications

Resources

Exercise Nurtrition Community Group

FIGURE 27B: Affer.
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

2. In Appointments, re-label "Recommendations” to "Next Steps."

MO Visual Dashboard Prototype // updated 27sep2012

acGoodman  Logout L}

e Appointments v You have 5 appointments in the coming week.  sccrch cppammens (1]

Upcoming + Find a Class Event Details

Dr. Berg - Physical Examination 30 Sun 1 Mon 2 Tue 3 Dr. Berg
Wed, Oct3, 1100 hrs —_—
0600 012 3t 1030
Dr. Greenfield - Allergies 012 5111:00
Fri, 0ct 5,0030 hrs S e e e B
Dr. Berg - Flu Vaccination
Thu,Oct 11, 1130 hrs

0700

9) 995-9999
Address The New York Clinic
Dr. Berg - Physical Examination 99 Main 5t.
Thu,Oct 4, 1030 hrs New York, NY 11111

Message Dr. Ber
Recommended

Cancel Appoinment

Gentle Chair Yoga
ul

October 2012

M TWTF

znq 5

10 1
6 17 18
24

) ------

One error in opening the page. For more information, choose Window > Activity. %

FIGURE 28A: Before

[x] TATRC2_GUI_appointments_01.ai
Healthb Available  IsaacGoodman ¥  Help

APPOI ntments v You have 2 appointments in the coming week. _

November 2011 Dr. Gregory Berg, Team 1
From Now 16, 2011 at08:30
Sunday Monday Tuesday ‘Wednesday Thursday Friday Saturday To Nov16 2011361145

Type Routine
Classification  Outgatient
RFV Cheonic back pain

7

Next Steps
1999) 6999999
Tetanus Vaccination The New York Clinic
Schedule Appointment % Mainse.
Gentie Chair Yoga NewYork, NY 11111

S MessageTeam |

Cancel Appointment

16
0830 Or. Berg.
1145 Dr. Hammond

November 2011
S MTWTEFS
123 4 567
8 91011 1213 14
'EE“ 18 19 20 21
22 23 24 25 26 27 28
29 30

FIGURE 28B: After.
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

APPTO5
Your doctor recommende.d a “chair yoga APPTO5: Mean Scorecard Return,
class. How would you register?
Group Avs. B
GROUP A DETERMINATION:
No Issues i Task Complexity & Visual Design = Overall Appeal
TASK NOTE
6.0
« 17% decrease in task success, likely 3.8
due to fall-out from failing the previous 4.0 27 3.5 3.5
task. )
Group A Group B
Mean Success Observed Time:
APPTO5 Benchmark Time
APPTO5
120
100 3.00
80 2.50
2.00
60
1.50 A
40 1.00 -
20 0.50 -
0 0.00 -
Group A GroupB Group A GroupB
Observed Path: Mean Number of
Benchmark Path Errors
APPTO5 APPTO5
6.00 1
5.00 0.8
4.00 0.6
3.00
200 “amm———— 0.4
o | [ T
0.00 - 0 -
Group A Group B Group A Group B
PIIM RESEARCH © 2013 PARSONS INSTITUTE
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

MEDRECO02

How would you mark that Next Step as MEDREC02: Mean Scorecard Return,
completef Group Avs. B

GROUP A DETERMINATION:
Minimal Issues i Task Complexity & Visual Design Overall Appeal

« Marking a Next Step as complete just
assigns a check mark; no other action 6.0 4.8
happens.

48 45

GROUP B VALIDATION:
Revert or Revise

o Task Complexity:
142% increase, from 2.0 to 4.8

Group A Group B
« Visual Design:
142% increase, from 2.0 to 4.8
o Overall Appeal: .
108% increase, from 2.2 to 4.5 Mean Success Observed T'r'ne'
MEDREC02 Benchmark Time
« Successful Completion: 120 MEDRECO2
67% decrease, from 100% to 33% 3.00
100 :
o Observed Time: 80 2.50
Benchmark: 180% increase, 60 2.00
from 0.61 to 1.71 1.50 -
40 1.00 -
o Observed Path: 20 050 -
Benchmark: 276% increase, ’
from 0.48 to 1.81 0 0.00 -
Group A GroupB Group A GroupB
o Error Rate: 0.33, up from 0
o Completion of this task was depen- Observed Path: Mean Number of
dent on a previous “next steps” task Benchmark Path Errors
(MEDRECO1). Because testers could MEDRECO2 MEDRECO2
not locate the Next Steps area, testers
failed to complete this task. 6.00 1
5.00 0.8
« No direct usability issues were 4.00
observed in those that successfully ' 0.6
completed the task. 3.00 0.4
2.00 '
RECOMMENDATIONS 1.00 A 0.2 1
See Recommendations under task 0.00 - 0 -
MEDRECOL. GroupA GroupB Group A Group B
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

ATTEMPTED FIXES
When marking a “Next Step” as complete, it should fade away or go to a completed state, perhaps accessible in History.

YaYe) Visual Dashboard Prototype // updated 27sep2012

IsaacGoodman  Logout §}

Medical Records v  Youhave 1 newmedical record. v maccaecorss [

TimeRange: 1d 1w 1m 3m 1y 3y Al Custom -

Type of Service | Date

Visits

PCP

Specialist

=

Diagnostic Studies

Radiology

Labs

Clinical Tests

Surgeries

Procadures

Decto a1 Feb11 Marn Aw,“ May'n Jun1n i A“g,“

[l OutpatentServices () Inpatient Services

Total Service Usage My Next Steps History

Outpatient Services - Startthe Physical Rehabilitation regimen we spoke about. Our Gentle Chair Yoga
inthe past year class would be beneficial if you find the ti
Recommendation: Gentle Chair Yoga Class

+ Unmark completed

Remove

Diagnostic Services * Continue to check blood sugar twice daily.

: Mark completed
inthe past year Recommendation: Set a Reminder

Remove

One error in opening the page. For more information. choose Window > Activity. “%

FIGURE 29A: Before

aNno Visual Dashboard Prototype // updated 13nov2012

You have 1 Next Steps & Isaac Goodman  Settings  Logout

What's this? View: (3) In Progress (O All
Urgency Date Next Steps Assignee Status

| 11/16/2012 Tetanus Vaccination Dr. Berg InProgress + )

Messagef

Exercise Nutrition Educational Community Group Medications
Resources

FIGURE 29B: After. When an item is marked as complete, it fades out after one second,
and is then accessible by selecting View > All.
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

MEDRECO3
Where would you find a history of Next MEDREC03: Mean Scorecard Return,
Steps?
Group Avs. B
GROUP A DETERMINATION:
No Issues i Task Complexity & Visual Design Overall Appeal
GROUP B VALIDATION:
Revert or Revise 6.0
« Visual Design: 4.0 35 35 33
110% increase, from 1.7 to 3.5
4o 1.7 15
2.0 12
o Overall Appeal:
122% increase, from 1.5 to 3.3 00 -
A B
o Successful Completion: Group Group
33% decrease, from 100% to 66.6%
o Observed Time:
Benchmark: 174% increase, from 1.06 )
to 2.90, indicating testers had a hard Mean Success Observed T'r'ne'
identifying how to solve the task. MEDRECO3 Benchmark Time
MEDRECO03
E R 6 f 120
o Error Rate: 0.67, up from 0 100 3.00
« Completion of this task was depen- 80 2.50 1
dent on a previous “next steps” task 2.00
60
(MEDRECO1). Because testers could 1.50 -
not locate the Next Steps area, testers 40 1.00 -
failed to complete this task. 20 050 -
« Given this, Mean Success did not 0 0.00 -
drop as severe as other metrics. Testers GroupA  Group B Group A Group B
found workaround ways to solve
the task. By going into the Appoint-
m'ents module and changing to Table Observed Path: Mean Number of
View, testers we“re. able to find what ) Benchmark Path Errors
amounted to a “history of next steps. MEDRECO3 MEDRECO3
See FIGURE 29C.
6.00 1
RECOMMENDATIONS 5.00 0.8
See Recommendations under task
4.00
MEDRECO]1. 0.6 -
3.00
2.00 0.4
0.00 - 0 -
Group A Group B Group A Group B
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

ann Visual Dashboard Prototype // updated 13nov2012

You have T Next Steps ¥ Isaac Goodman  Settings  Logout

You have 4 appointments in the coming week.

+Request an Appointment [+ Find aClass Export Event Details

Date of Service Type Provider Description NextSteps  Status OxPerm

From Dec 12,2012 at 130

Sep7,2012- 1100 am Appointment Dr.Berg Nasal Procedure Completed R

Oct11,2012-11:00 am Appoirtment  DrHammond  Consultation Completed Type Routine
Wed, Dec 12, 1300 hrs 0ct11,2012- 100 pm Appoirtment  Dr, Berg Surgery Completed Classific. Outpatient
; REV Physical Therapy

field - Oct 11,2012- 400 pm Appointment Dr. Rothstein Blood Test Completed Phone (999) 999.0999
kot ) Oct11,2012-700pm Appoimment  OrHammond  Cardiac StressTest Completed

Fri, Dec 1+ 99 Main St

Nov 16,2012-11:00 am Appaintment Dr. Berg Physician Examination Completed New York, NY 11111

Message D
Nov 16,2012- 100 pm Appointment D, Beg M Completed feme oy
Dec7,2012-11:00am Appoirtment  Dr.Berg Appendactomy Completed Cancel Appointment

L RN Dec7,2012-200 pm Appointment Dr. Berg Colonscopy Completed

JRCRR e Dec 11,2012 11:00am Appointment Dr. Berg Physical Examination Scheduled
Schedule nent

Dec 12,2012- 100 pm Appoirtment  Dr.Beng Physical Therapy Scheduled
Dec 14,2012-930am Appointment Dr Greenfield  Allergies Scheduled

Dec 16,2012-11:00 am Appointment Dr. Berg L] Campleted

Dec16,2012-1130am Appointment Dr. Berg FluVaccination Scheduled
December 2012

S MTWTEF S
1

4 5 6 7 8
oz iz e
17 18 19 20 21 22
24 25 26 27 28 20

Ell

_
FIGURE 29C: Testers used this view to report a history of next steps.
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PIHMRES[EARCH

APPTO02, 06

You just remembered you have an appointment
with a new doctor coming up soon regarding
your allergies. When is it?

GROUP A DETERMINATION:
No Issues

PIIM RESEARCH
PUBLISHED FEBRUARY 15, 2013
[PAGE 801

THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:

USABILITY TESTING RESULTS

APPTO02, 06: Mean Scorecard Return,
Group Avs. B

i Task Complexity & Visual Design  Overall Appeal

6.0
4.0
2.7
23 23 ’
22 2.2 1.8
2.0 ‘ S —
0.0 -u
Group A Group B
Mean Success Observed Time:
APPTO02, 06 Benchmark Time
APPT02, 06
120
100 3.00
80 2.50 -
2.00 -
60
1.50 -
40 1.00 -
20 0.50 -
0 0.00 -

Group A Group B

Group A Group B

6.00
5.00
4.00
3.00
2.00
1.00
0.00

Observed Path:

Benchmark Path
APPT02. 06

Group A Group B

Mean Number of

Errors
APPT02. 06

0.8

0.6

0.4

0.2

0 -

B

Group A Group B

PIIM

© 2013 PARSONS INSTITUTE

FOR INFORM
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PIHMRES[EARCH

MEDSO03

You want to show the new doctor a prescrip-
tion medication you took last year related

to the new appointment. How would you

go about finding it? How would you find
information on it?

GROUP A DETERMINATION:
Moderate Issues

o Successful Completion:
66.6% (Tied 4th Worst)

o Task Complexity:
142% increase, from 2.0 to 4.8

o Visual Design:
142% increase, from 2.0 to 4.8

o Overall Appeal:
62.5% increase, from 2.2 to 4.5

o Observed Time:
Benchmark: 2.07 (6th Worst)

o Testers had trouble grasping All versus
Inactive medication.

GROUP B VALIDATION:
Improved

o Successful Completion:
50% increase, from 66% to 100%

RECOMMENDATIONS

« Because of negative scorecard results,
another examination of verbiage and
visual design might help mitigate
negative perception.

PIIM RESEARCH
PUBLISHED FEBRUARY 15, 2013
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THE VISUAL DASHBOARD & HEADS-UP DISP
USABILITY TESTING RESULTS

LAY OF PATIENT CONDITIONS:

MEDSO03: Mean Scorecard Return,

Group Avs. B

i Task Complexity & Visual Design

Overall Appeal

Group A Group B
Mean Success Observed Time:
MEDSO03 Benchmark Time
MEDS03
120
100 3.00
80 2.50
2.00 -
60
1.50 -
40 1.00 -
20 0.50 -
0 0.00 -

Group A GroupB Group A GroupB
Observed Path: Mean Number of
Benchmark Path Errors

MEDS03 MEDS03

6.00 1
5.00 08
4.00 06
3.00
2.00 - 0.4
1.00 0.2 :.:
0.00 - 0 -

Group A Group B Group A Group B

P I I M © 2013 PARSONS INSTITUTE
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

ATTEMPTED FIXES
1. Change filter label to “View;” and new options are Current Meds, Discontinued Meds, and All Meds.

YaYe) Visual Dashboard Prototype // updated 27sep2012

lsaacGoodman  Logout b

Medications v You have 2 medications you need to refill now or soon. _ﬂ

[ Medication Histary |
+ Add Medication . TimeRange: 1w 1m 3m 1y 3 Al cuom [I[EE] Allergies

Medication Name Date e,
ex (Do Not Use, Not Screened)
tural Rubber (Do Not Use, Not
Prescription Drugs Sereened)

Lisinoprl (Prinvil/Zestril) [} Conditions

- Hypertension
« High cholasterol

Pharmacy Alert

Renewal Reminders

Supplements
- Request renewal for Lisinopril

+ Request renewal for Coumadin®
Femous Sulfate Requs

Herbal Medicines

Jang Ya Pian T e I L il e e —

Wed, Jun 13 Thu, Jun 14 Fri,Jun 15 Sat,Jun 16 Sun, Jun 17 Mon, Jun 18 Tue, Jun 19

[ Scheduled @ Asneeded | Overdose/underdose
[ Mot Taken

One error in opening the page. For more information. choose Window > Activity. %

FIGURE 32A: Before

TATRCZ_GUI_madications_01.0_timelineview_VIEW+Record_01.a

Avallable  lsaacGoodman  Settings  Logout

Medications ~ You have 2 medication: . _ﬂ

Learn more about Medication:

Medication History ‘

+ Add Medicstion A Cuventivecs TmeRange: Tw Im 3m 1y 3y Al Custom Updatas

Current Meds
Discontinued Meds
Al Meds

Medication Name Today =Your renewal request for HCTZ

(Esldrex/Oretic) PO 25mg Tab
Prescription Drugs

Lisinopril PrinivIlZestril

PO 40mgTab

HCTZ (Esidrex/Oretic)

PO25mgTab ~Latex (Do Not Use, Not Screened)
*Natural Rubber (Do Not Use, Not

Warfarin (Coumadin®) Screenec)

PO SmgTab

Over-The-Counter Drugs Conditions

~Hypertension

Acetaminophen (Tylenol* PM) ~High cholesterol

Supplements
ki Pharmacy Alart

Fem ifate
PO 325mgTab

Lipodrene Renewal Reminders

Harbal Medicines +Request renewalfor Lisinopril
~Request renewalfor Coumadin®

Jiang Ya Piam HEE B g B
+Request Renewal
Sun, June 15 Mon, June 16 Tue, June 17 Wed, June 18 Thu, June 19 Fil, June 20 Sat,June 21

[ Scheduled @ NotTaken @ Asneeded !, overdosefunderdose

FIGURE 32B: Affer
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

MEDRECO06
Next, you want to show the new provider the MEDRECO06: Mean Scorecard Return,
results of a past blood test. Where would you
find it? Group Avs. B
GROUP A DETERMINATION: W Task Complexity & Visual DeSign ~ Qverall Appeal
Moderate Issues
o Visual Design: 3.0 (Tied 4th, Worst) 6.0
o Successful Completion: 83.3% 4.0 78 30 27
2.3 23 202 )
e Observed Time: 20 T L —
Benchmark: 2.7 (3rd Worst)
0.0 -
o Observed Path: Groun A Grouo B
Benchmark: 5.44 (Worst) P P
Note: Upon investigation, PIIM deter-
mined this data was actually a false
positive. Tester P-02 was a “heavy .
scroller” Each action on the scroll wheel Mean Success Observed T'r'ne'
(mouse middle button) is counted as MEDRECO6 Benchmark Time
part of the user’s path. 120 MEDRECO6
3.00
« Some testers tried to click on service 100
sub-types (e.g. Labs), as well as other 80 2.50 1
2.00 -
parts of the ur. 60
1.50 -
GROUP B VALIDATION: 40 1.00 -
Improved 20 050 -
o Successful Completion: 0 .
20% increase, from 83% to 100% GroupA  Group B GroupA  Group B
Observed Path: Mean Number of
Benchmark Path Errors
MEDRECO06 MEDRECO06
6.00 1
5.00 A 0.8
4.00 - 0.6
3.00 -
2.00 A 0.4
1.00 - 0.2
0.00 - 0 T )
Group A Group B Group A Group B
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

ATTEMPTED FIXES
For consistency, add the Today label on the timeline.

YaYe) Visual Dashboard Prototype // updated 27sep2012

lsaacGoodman  Logout b

Immunizations v You have 12 immunizations due or due soon. _m

Learn more about Immunizat

view: [THEY TmeRange: 1m 3m 1y 3y Sy 10y Al Custom [ Allergies

Immunization » Aspirin
(Do Not Use, Not Screened)

« Natural Rubber (Do Not Use, Not

Anthrax Screened)

Hepatitis A
Exemption
Hepatitis B

Influenza

Japanese encephalitis

Rubella
Smalipox
Td/Tdap
Typhoid
Varicella
Vellow Fever
Jan12 Feb12 Mar12 Apri2 May 12 Juni2 Juliz Aug1z sep12 Oct12 Nov12 Dec12

Due @ Duewithin1month Addressad Today for Immunizations Have BeenGiven @ Completed

One error in opening the page. For more information. choose Window > Activity. %

FIGURE 37A: Before

TATRCZ_GUI immunizations_1.1_t_lyr.al

Avallable  lsaacGoodman v  Help

Immunizations ~ You have 4 immunizations dt 3 _ﬂ

Learn more about Immunization: £

P T — l—
View: M Time Range: 1m 3m 1y 3y 5 10y Al cusom  [EHEE] Allargles

Immunization Today e Fs
+Latex (Do Not Use, Not Screened)
Anthrax + Natural Rubber (Do Not Use, Not
Screened)
Hepatitis A

Hepatitis B Exemption

Measeles
Meningococcal
Mumps

Poliovirus

Rables

Rubella

Smalpox
Tetanus—diphtherla
Typhoid

Varicell

Yellow Fever .

Ol Novl0  Decl0  Janit'  Feb11'  Maril’  Aprit'  Mayi?'  Junit’  Jul1l'  Augit’  Sepil’  Oair

Due @ Due within 1 month Addressed Today for Immunizations Have Been Given @ Completed

FIGURE 37B: Affer
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

MEDRECO05
How would you show the provider details MEDRECO5: Mean Scorecard Return,
about the nasal procedure you had?
Group Avs. B
GROUP A DETERMINATION:
No Issues i Task Complexity & Visual Design = Overall Appeal
6.0
4.0 23 27
2.0 )
2.0 13 15 17
Group A Group B
Mean Success Observed Time:
MEDREC05 Benchmark Time
MEDRECO5
120
100 - 3.00
20 - 2.50
2.00 -
60 -
1.50 -
40 1 1.00 -
20 7 0.50 -
0 - 0.00 -
Group A GroupB Group A GroupB
Observed Path: Mean Number of
Benchmark Path Errors
MEDRECO5 MEDRECO5
6.00 1
5.00 0.8
4.00 0.6
3.00 -
2.00 A 0.4
1.00 - 0.2
0.00 - 0 T )
Group A Group B Group A Group B
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

MEDRECO7
You want to give your medical record to MEDRECO07: Mean Scorecard Return,
your new doctor. How would you do that?
Group Avs. B
GROUP A DETERMINATION:
No Issues i Task Complexity & Visual Design Overall Appeal
o Observed Time:
Benchmark: 2.72 (2nd Worst) Note: 6.0
This is another false positive caused
by Tester P1-02 exploration of around 4.0 3.0 78
3 minutes. 2.5 : 25 723 2.7
2.0 1 ‘ —
« Export button does not work. If the
situation was appropriate, moderator 0.0 -
asked: “What do you think would '
. Group A Group B
happen when you click the Export
button?” Consistently, each tester
responded with something like: “I'd
be asked to choose my format, like
PDF, then asked who to send it to..” X
This is a fairly powerful feature in a Mean Success Observed T'r'ne'
PHR, and might be worth mocking MEDRECO7 Benchmark Time
u MEDRECO7
p- 120
3.00
GROUP B VALIDATION: 100
Improved 80 2.50 1
2.00 A
. 60
o Observed Time: 1.50 -
Benchmark: 50% decrease, 40 1.00 -
from 2.72 to 1.36 20 050 -
o Observed Path: 0 .
Benchmark: 57% decrease, GroupA  Group B Group A Group B
from 4.03 to 1.71
* These metrics are likely improved Observed Path: Mean Number of
beca}use of the addition of a confir- Benchmark Path Errors
mation message. Testers felt more MEDRECO7 MEDRECO7
comfortable announcing “Done!”
See FIGURE 40A. 6.00 1
5.00 0.8
4.00 A 0.6
3.00 A
2.00 - 04
1.00 - 0.2
0.00 - 0 T )
Group A Group B Group A Group B
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

ann Visual Dashboard Prototype // updated 13nov2012

You have T Next Steps ¥ Isaac Goodman  Settings  Logout

Medical Records v Your file has been exported —E

mm TimeRange: 1d 1w Tm 3m 1y 3y Al Custom -

Type of Service | Date Today
Doctor Visits

Primary Care

Speclalist

ER
Tests

Radiology

Labs

Cliniical Tests
Procedures L @
Surgeries T A —

Feb12 Mar12 Apr12 uay}z un12 iz g2 sep12 :

[ OutpatientServices (@ Inpatient Services

Total Service Usage Problem List

8 Outpatient Services The patient is experiencing
in the past year high levels of stress in the past
few months.

Diagnostic Services
In the past year

FIGURE 40A: Export Confirmation Message
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PIHMRES[EARCH

MSG04

How would you send a new (urgent) message
about Warafin (which is making you feel
jittery)?

GROUP A DETERMINATION:
No issues

PIIM RESEARCH
PUBLISHED FEBRUARY 15, 2013
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

MSGO04: Mean Scorecard Return,
Group Avs. B

i Task Complexity & Visual Design  Overall Appeal

6.0
4.0
29 2.7 23 5y 2.3 2.7
2.0 —
0.0 -
Group A Group B
Mean Success Observed Time:
MSG04 Benchmark Time
MSGO04
120
100 - 3.00
80 - 2.50
2.00
60 -
1.50 -
40 1.00 -
20 0.50 -
0 - 0.00 -

Group A GroupB Group A GroupB
Observed Path: Mean Number of
Benchmark Path Errors

MSGO04 MSGO04
6.00 1
5.00 0.8
4.00 06
3.00
2.00 0.4
0.00 - 0 -

Group A Group B Group A Group B
P I I M © 2013 PARSONS INSTITUTE
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

PIIMR[ESEARCH

MSG05-08

You sent a message containing a sensitive
image to your HealthBoard team a few weeks
ago, and now you want to delete it. You know
it’s an e-mail about a “sinus surgery” How

do you go about finding it, and permanently
deleting it?

MSGO05-08: Mean Scorecard Return,
Group Avs. B

i Task Complexity & Visual Design

Overall Appeal

GROUP A DETERMINATION: 6.0
Moderate issues
4.0 33 33 a5
: =e 28 28 ,¢
o Task Complexity: 3.3 (Tied 3rd Worst) :
2.0 —
o Visual Design: 3.3 (2nd Worst)
Overall Appeal: 3.2 (2nd Worst) 00"
o Overall Appeal: 3.2 (2nd Wors Group A Group B
o Successful Completion:
33.3% (2nd Worst)
« Participants had a hard time recogniz- .
ing the search bar. One reason for this Mean Success Observed Tlr'ne'
could have been that some had tried MSG05-08 Benchmark Time
to use it in other modules, and 120 MSG05-08
perhaps had it in their heads that 3.00
the search was not functional across 100 '
modules. 80 2.50
€0 2.00
o Participants did not realize messages 1.50 -
were not permanently deleted. 40 1.00 -
p t.: 000 |
GROUP B VALIDATION:
0 - 0.00 -

Indeterminate

« Data is unchanged or invalid. Errors
in Group B were due to tester failure
to permanently delete the message.
This was not considered an error

Group A Group B

Group A Group B

Observed Path:

Mean Number of

; _ Benchmark Path Errors
in Group A. Path data is anomalous. MSGO05-08 MSGO5-08
o Users continued to fail to understand 6.00 1
their messages were not permanently 5.00 08
deleted when deleted from the Inbox. '
4.00 0.6
RECOMMENDATIONS 3.00 0.4
2.00 - ’
 Tweak confirmation message ver- 1.00 - 0.2 1
biage: “You message has been moved 0.00 - 0 -

to Trash.”

Group A Group B

Group A Group B

© 2013 PARSONS INSTITUTE
FOR INFORMATION MAPPING
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

ATTEMPTED FIXES

Add confirmation messages to actions.

806

Healthboard

Visual Dashboard Prototype // updated 13nov2012

You have T Next Steps ¥ Isaac Goodman  Settings  Logout

{T) Messages v Your message has been deleted

MAILBOXES
Inbox (3)
Drafts
Sent

Physician

Trash August 25,2011

Nurse
= u August 22,2011

Front Desk
= u February 2, 2011

Show: All, Unread  Sortby: Dats

(2) Low glucose levels
Hi,..

(3) Chronic pain
3rd messageceece

Persistent cough
Ut enim ad minim veniam, quis nostrud exercitation ullamco |aboris nisi ut ...

FIGURE 41A: Confirmation Message Template
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

GENO1
How would you go about changing your .
GENO1: Mean Scorecard Return,
password?
Group Avs. B
GROUP A DETERMINATION:
No issues i Task Complexity & Visual Design = Overall Appeal
6.0
4.0
2.8 2.8
2.7 23 55 2.7
2.0 —
0.0 -
Group A Group B
Mean Success Observed Time:
GENO1 Benchmark Time
GENO1
120
100 - 3.00
80 - 2.50
2.00 -
60 -
1.50 -
40 1 1.00 -
20 0.50 -
0 - 0.00 -
Group A GroupB Group A GroupB
Observed Path: Mean Number of
Benchmark Path Errors
GENO1 GENO1
6.00 1
5.00 0.8
4.00 0.6
3.00
2.00 0.4
0.00 - 0 T )
Group A Group B Group A Group B
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GENO04
HealthBoard will e-mail you notifications GENO04: Mean Scorecard Return
and reminders, such as when you have any !
upcoming appointment. How would you Group Avs. B
adjust these notification settings?

K Task Complexity ¥ Visual Design Overall Appeal
GROUP A DETERMINATION:
Severe issues

6.0

o Task Complexity: 4.5 (Worst) 4.5

3.7 3.7

o Visual Design: 3.7 (Worst)

o Overall Appeal: 3.7 (Worst)

o Successful Completion: 50%

A B
(3rd Worst) Group Group
o Error Rate: 0.17
GROUP B VALIDATION: §
Improved Mean Success Observed Tlr'ne.
GENO4 Benchmark Time
o Task Complexity: 120 GENO4
56% decrease, from 4.5 to 2.0
100 - 3.00
o Visual Design: 80 - 2.50
36% decrease, from 3.7 to 2.3 60 2.00
1.50 -
o Overall Appeal: 40 - 1.00 -
27% decrease, from 3.7 to 2.7 20 - 050 -
o Successful Completion: 0 - .
100% increase, from 50 to 100 GroupA  Group B GroupA Group B
o Error Rate: 0, down from 0.17
Observed Path: Mean Number of
« Testers definitely understood Settings Benchmark Path Errors
versus the previous gear icon. GENO4 GENO4
RECOMMENDATIONS 6.00 1
5.00 0.8
o The changes were successful, show-
.. . . 4.00
ing increased user satisfaction and 0.6
completion rate. 3.00 0.4
2.00 ’
0.00 - 0 -
Group A Group B Group A Group B
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ATTEMPTED FIXES
Time and time again, users failed to identify the gear mean as Settings. Testers would navigate from module to module in
search of it. p11M changing the wheel icon to a link called Settings, and positioned it closer to the user’s name.

! Ne Visual Dashboard Prototype // updated 27sep2012

" i
/|83l Il

Messages Appointments ic Immunization Vital Signs

Isaac Goodman

Preferences
@ [A] Default point size

Homepage Options =
O [A] + pointsize
O | A +2pointsize

Notifications (Lo |

Units
Height

—
=

Exercise Medications

(2) American i or (3) American poune

(O International 1 () International

(One error in opening the page. For more information. choose Window > Activity. %

FIGURE 44A: Before

“TATRC2_GUI_Home003_viewoptions.al

Preferences Font Size

® [A] Defalutpointsize
O [A] + pontsize
() \A +2 point size

Homepage Options
Fontand Units
Natifications

Units

Height

® American inchicct @  American oo

QO International fcm) Q International (i

Save settings | Cancel |

FIGURE 44B: After
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GENO5
How wo'uld you make all the text on the GENO5: Mean Scorecard Return,
screen bigger?
Group Avs. B
GROUP A DETERMINATION:
MINIMAL ISSUES i Task Complexity & Visual Design = Overall Appeal
« Despite 100% successful completions,
testers did not understand what 6.0
“Type and Units” means. One tester
commented, “That makes me think 4.0
of ‘blood type.” 25 25 2.0 15 22 2°
2.0 —
GROUP B VALIDATION:
Improved 00 -
A B
o Observed Time: Group Group
Benchmark: 20% decrease,
from 1.75 to 1.40
o Testers completed the task with ease.
Mean Success Observed Path:
GENO5 Benchmark Path
GENO5
120
100 - 6.00
%0 1 5.00
4.00
60 -
3.00
40 7 2.00
0 = 0.00 -
Group A GroupB Group A GroupB
Observed Path: Mean Number of
Benchmark Path Errors
GENO5 GENO5
6.00 1
5.00 0.8
4.00 0.6
3.00
2.00 0.4
0.00 - 0 -
Group A Group B Group A Group B
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ATTEMPTED FIXES
Change to “Font and Units.”

! Ne Visual Dashboard Prototype // updated 27sep2012

Messages Appointments cal R ds Immunization Vital Signs

lsaac Goodman  Logout ¥

Preferences Tipe size

@ [A] Default point size

i ' | Homepage Options =
O [A] + pointsize

Sl - ot

i Notifications L2

Exercise Medications

(2) American i or (3) American poune

(O International 1 () International

(One error in opening the page. For more information. choose Window > Activity. %

FIGURE 45A: Before

“TATRC2_GUI_Home003_viewoptions.al

Preferences Font Size
® [Al Defalut point size
O [A] + pontsize

Fontand Units < 1
() \A +2 point size

Notifications

Homepage Options

Units
Height
® American inchicct @  American oo

QO International fcm) Q International (i

Save settings | Cancel |

FIGURE 45B: After
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GENO6
How would you change the homepage view of GENO6: Mean Scorecard Return,
your HealthBoard?
Group Avs. B
GROUP A DETERMINATION:
No issues i Task Complexity & Visual Design  Overall Appeal
o Observed Time:
Benchmark: 2.85 (Worst) Note: 6.0
This is a false positive, as Tester P1-06
accidentally logged out, and had to log 4.0
back in. L7 19 . 23 25
20 15 . . . -
0.0 -LL
Group A Group B
Mean Success Observed Time:
GENO6 Benchmark Time
GENO6
120
100 - 3.00
20 1 2.50 -
2.00 -
60 -
1.50 -
40 7 1.00 -
20 7 0.50 -
0 - 0.00 -
Group A GroupB Group A GroupB
Observed Path: Mean Number of
Benchmark Path Errors
GENO6 GENO6
6.00 1
5.00 0.8
4.00 0.6
3.00
2.00 A 0.4
1.00 - 0.2
0.00 - 0 T 1
Group A Group B Group A Group B
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Group 2 Task: Task Analysis

« Vital Signs
« Exercise
o Nutrition

+ Educational Resources
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GENO3
Please login with the persona you've been
provided.

GROUP A DETERMINATION:
No issues

PIIM RESEARCH
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GENO3: Mean Scorecard Return,

Group Avs. B
& Task Complexity & Visual Design = Overall Appeal
7.0
6.0
5.0
4.0
3.0 2.0 23
2.0 10 1.0 12— 12
1.0 _ - —
0.0 ~
Group A Group B
Mean Success Obv. : Benchmark
GENO3 Time
EN
120 GENO3
100 - 5.00
80 - 4.00
60 - 3.00
40 - 2.00
0 - 0.00 -
Group A GroupB Group A Group B
Obv. : Benchmark Mean Number of
Path Errors
GENO3 GENO3
8.00 1
6.00 0.8
0.6
4.00
0.4
2.00 A 0.2
0.00 - 0 T )
Group A Group B Group A  Group B
P I I M © 2013 PARSONS INSTITUTE
FOR INFORMATION MAPPING




PIHMRES[EARCH

NUTRO1

For the last six months, you've been using
HealthBoard to maintain a healthy weight
through diet and exercise. Report eating
a grilled cheese sandwich with tomato

for lunch.

GROUP A DETERMINATION:
No issues

o Most testers by-passed the help
pop-up; consider making available
on demand.

o Testers seem confused after completing
the task, wondering where their meal
went.

o Users seem confused by the What
portion? input. For a sandwich, it’s
hard to tell which option is relevant.

GROUP B VALIDATION:
Revert or Revise

o Task Complexity:
40% increase, from 2.0 to 2.8

o Visual Design:
60% increase, from 2.0 to 3.2

o Overall Appeal:
76% increase, from 1.7 to 3.0

o Successful Completion:
17% decrease, from 100% to 83.33%

o Observed Time:
Benchmark: 89% increase,
from 1.58 to 2.99

o Observed Path:
Benchmark: 60% increase, from 1.31
to 2.10

o Error Rate: 0.17, up from 0
« No participant used the Other field.
o All participants seem confused by

the Add a favorite meal dropdown.
Consider a different treatment that

PIIM RESEARCH
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NUTRO01: Mean Scorecard Return,
Group Avs. B

& Task Complexity & Visual Design

Overall Appeal

7.0
6.0
5.0
4.0 28 3.2 3.0
3.0
20 2.0 1.7
2.0 ——
1.0 - —
0.0 =
Group A Group B
Mean Success Obv. : Benchmark
NUTRO1 Time
NUTRO1
120 UTRO
100 - 5.00
80 - 4.00
60 - 3.00 A
40 - 2.00 A
20 - 1.00 -
0 - 0.00 -

Group A Group B

Group A Group B

Obv. : Benchmark

Path
NUTRO1
8.00
6.00
4.00

0.00 -

Group A Group B

Mean Number of

Errors
NUTRO1
1
0.8
0.6
0.4
0.2
ol M

Group A  Group B
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removes the drop-down from the
screen.

Consider a different treatment for
What Portion? Each tester entered

in a different unit (e.g. plates, servings,
etc.); one tester ignored the option
completely. Maybe a more vernacular
reference like “palm(s) of my hand”
can be used. The goal should be to
communicate the record to the
dietician as accurate as possible.

There may also be a different treatment
of the meal type (e.g. breakfast, dinner)
that could improve efficiency and
reduce error. Showing these options
on screen may accomplish this.

Generally, users will not enter any
notes. Perhaps hide this field to reduce
confusion, or only make it available
on-click.

ATTEMPTED FIXES
1. Add an Other field for the use to create a custom unit.

Healthboard IsaacGoodman  Logaut {0}

Nutrition v You have no new notifications [scac o |10

‘ Summary || MyFood Plan Myhndhwnll‘

December 18,2012

Record a Meal (7] My Food Journal My Food Plan

D CrT—D
o : 45 dally servings
grilled cheese with tomato ings

¥ -3 daily servings
o 2 =] Iy
W jon:
5 _ﬂ Meat. poultry and fi ess daily servings

Nuts, seeds & dry beans: 45 servings per week

Enterwhen, where, and why yd PIaes ‘ W Fatsand oils: 7-3 dai ings
B Sweets: limit to fess than 5 servings per week

What can | eat?

1200 1600 2000 cals. Remember, get most of calories from fruits,
vegetables and starches.

Record Water Intake

My Health Focus
Limit View More »
ons today?

: - ' & i
‘ L] -
Did you exercise today? Log your £ | | ‘ M_,." fa v & J

Check or view your weight in Vital Sig T

FIGURE 47A: Before: No “Other” option exists.
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Healthboard You have 3 Next Steps ¥ lsaac Goodman  Settings  Logout

Nutrition v You have no new notifications e

| My Food Journal | | My Food Plan

m TimeRange: 1d 1w Im 3m Custom nm !-

December 18, 2012

Record a Meal @ Your Meal List

{secattost | - [l adoorovoiemest | - [IRILE Food 4 Portion Calories Comments

Dinner Spaghetti and meatb... 1plate | 450 |ate too much. Felt like | was having a heart at.

grilled cheese sandwich with tomato Breakfast | Spinach quiche 1piece | 342

Total Calories Taken Your Food Plate

- 0 cals.
[ suonc [

Daily Budget: 2,000 Calories

+0 Cals.Taken
-0 Cals.Burned

Total Calories Taken

Cals. From Fats & Qils
Cals. From Sugar
(Cals. From Alcohol

FIGURE 478B: After: p11M added an “Other” option.

You have 3 Next Steps ¥ Isaac Goodman  Seftings  Logout

(1) Nutrition v  Youhave no new notifications e
5

[ My Food Journal My Food Plan |
v SEPA—TT ||

December 18, 2012

Record a Meal @ Your Meal List

ot e H Type Food 4 Portion Calories Comments Favorite
d

Dinner Spaghetti and meatb... 1plate 450 | ate too much. Felt like | was having a heart at

grilled cheese sandwich with tomato Brealfast | Spinach quiche 1piece 342

Total Calories Taken Your Food Plate

Enter when, where, and why you had the meal.
4 %<

Daily Budget: 2,000 Calories

1l +0 Cals.Taken
Record Water Intake z -0 Cals.Buned

40 Total Calories Taken

Cals. From Fats & Qils
Cals. From Sugar
Cals. From Alcohol

Calories from Extra

FIGURE 47C: After: Selecting the “Other” option reveals a text box for the user to create
their own unit.
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GENO2

HealthBoard is in “button view” by default.
Please change the “home screen” to “widget
view””

GROUP A DETERMINATION:
No issues

o Observed Time:
Benchmark: 3.38 (3rd Worst)

o Per PhaselA, p11m adjusted the “cog”
icon to be a Settings link. This change
occurred for the last two participants of
Phase2A, and is anecdotally validated
by comparing the time improvements
of the last two testers, seen below.

Time on Task (Seconds)

« P2-01 167.99
o P2-02 47.2
« P2-03 29.81
« P2-04 50.19
* P2-05 22.21
o P2-06 12.17

o Regarding the Dashboard, Tester
P2-04 stated “my initial reaction is...
wow, all this data!”

o After changing the widget view back
to button view, Tester P2-02 said it
was “just easier and [I] wasn't sure
where to be looking [in the widget
view].” “[The button view is] a little
less cluttered, I think.”

GROUP A DETERMINATION:

o For widget view, the arrow should ex-
pand and collapse the block, while the
text (e.g. Weight) should go to detail
page. For example, when a user clicks
on Blood Pressure from the widget
view, it should lead them directly to
that page in the module.
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& Task Complexity

GENO02: Mean Scorecard Return,

Group Avs. B

& Visual Design

Overall Appeal

7.0
6.0
5.0
4.0
2o 27 5c 30,7
' 2.0 18
2.0 - —
1.0 - ——
0.0 -
Group A Group B
Mean Success Obv. : Benchmark
GENO2 Time
ENO2
120 GENO
100 - 5.00
80 - 4.00
60 - 3.00 A
40 - 2.00 -
20 - 1.00 -
0 - 0.00 -

Group A Group B

Group A Group B

Obv. : Benchmark

Mean Number of

Path Errors
GENO2 GENO2
8.00 1
6.00 0.8
0.6
4.00
0.4
2.00 0.2
0.00 1“ 0 1¥
Group A Group B Group A  Group B
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PIIM

FOR INFORMATION MAPPING




PIHMRES[EARCH

VITALSO1

This morning you weighed yourself: 182 Ibs.

Enter that into HealthBoard.

GROUP A DETERMINATION:
No issues

PIIM RESEARCH
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VITALSO1: Mean Scorecard Return,

Group Avs. B
& Task Complexity & Visual Design = Overall Appeal
7.0
6.0
5.0
4.0 28 28 28 30
3.0 22 13
2.0 ——
1.0 —
0.0 -
Group A Group B
Mean Success Obv. : Benchmark
VITALSO1 Time
VITALSO1

120 S0
100 - 5.00

80 - 4.00

60 - 3.00

40 - 2.00 A

20 1.00 -

0 - 0.00 -

Group A Group B

Group A Group B

Obv. : Benchmark

Path
VITALSO1
8.00
6.00
4.00

2.00

oo | I

Group A GroupB

Mean Number of

Errors
VITALSO1
1
0.8
0.6
0.4
0 -

Group A  Group B
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VITALS02
How much did you weigh around this time
last year?

GROUP A DETERMINATION:
Minor issues

o Observed Time:
Benchmark: 4.12 (2nd Worst)

o Observed Path:
Benchmark: 4.64 (2nd Worst)

GROUP B VALIDATION:
Indeterminate

o Successful Completion:
33% decrease, from 100% to 66%

o Observed Time:
Benchmark: 42% decrease, indicating
the tool tips may have an effect on the
tester’s ability to seek information.

o Observed Path:
Benchmark: 17% decrease, from 4.64
to 3.87, again indicating the tool tips
may have an effect on the tester’s ability
to seek information.

RECOMMENDATIONS

o Perhaps adding a designation between
years in the bottom timeline would
help understand the graph’s scope?
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VITALS02: Mean Scorecard Return,
Group Avs. B

& Task Complexity & Visual Design

“ Overall Appeal

7.0

6.0

5.0

4.0 3.0 30

3.0
2.0
1.0 -
0.0 -

Group A

N
w

Group B

Mean Success
VITALSO2

120
100 A

40 A
20 -

0~
Group A Group B

Obv. : Benchmark
Time
VITALS02

5.00
4.00 -
3.00 -
2.00 -
1.00

0.00 -
Group A Group B

Obv. : Benchmark

Path
VITALS02
8.00
6.00
4.00
2.00
0.00 -

Group A GroupB

Mean Number of

Errors
VITALS02
1
0.8
0.6
0.4
0 -

Group A  Group B
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ATTEMPTED FIXES
When mousing-over a data point on a chart, add a popover which tells the user its values (e.g. “October 3, 2011; 195 Ibs.).

Healthbc IssacGoodman  Logout  §0F

1) Vital Signs v You have no new measurements. ﬂ

MY VITALS | +recoranais || eancon | Time Range: 1w 3 cuom  [IIEE]

All
My Weight

!:l;od Pressure 1 9 5 unds = 5 pounfﬂs . 2 7 1 BMI 'O . 6 BMI. 2 3 -7 BMI

Heart Rate Octobs fre October 1 frof 1" Target BM!

Respiratory
- | @ PatientEntry (O Provider Entry Reference:
Temperature -_—s

Height

Overweight

Augll  SepTl  Ocll  MNovll Decll  Jan12  Febl2 Marl2 May1l2  ni2  Jul12 Augl2 o

FIGURE 48A: Before: No “tool tip” appears for data.
Healthbcard You have 3 Next Steps ¥ Seftings  Logout

Vital Signs v You have no new measurements.

All
My Weight

Blood Pressure 1 9 5 pounds = 5

Heart Rate October3, 2011 from Se

Respiratory
@ FatientEntry () Provider Entry Reference:
Temperature

Height

Overweight 195 pounds on 10/03/2011

Jul11 Augll  Sepll  Oxtll  Movll Decll  Jan12 FeblZ  Mari2  Apri2  Mayl2 hni2 M2 Augl2  Sepl2  Octl2

FIGURE 48B: After: Tool tip with “node” value appears when hovering over the graph.
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VITALSO6

You last reported that your weight was 175 VITALS06: Mean Scorecard Return
Ibs. and temperature 103°. Go back and add a Group A vs. B ’

comment that you “had the flu”

& Task Complexity & Visual Design Overall Appeal

GROUP A DETERMINATION:
Severe issues

o Task Complexity: 4.5 (2nd Worst)

o Overall Appeal: 3.3 (Tie, 3rd Worst)

o Successful Completion:
33% (Tie x3, Worst)

o Observed Time:
Benchmark: 2.56 (6th Worst) Group A Group B

o Observed Path:
Benchmark: 2.85 (5th Worst)

« The test called for testers to find the Mean Success Obv. : Benchmark
task’s values, and add a comment. VITALS06 Time
Perhaps due to the absence of the 120.00 VITALSO06
“universal rule” specified in the design,
testers appeared to not associate the 100.00 >:00
Comment section (on bottom) with 80.00 4.00
the values in the sparklines. 60.00 3.00

« Most participants did not scroll to see 40.00 - 2.00 A
the Comment section. 20.00 - 1.00 -

« For those that did, the relevant 0.00 - 0.00 -
comment would display incorrect Group A Group B Group A Group B
information. This did not interfere
with the one tester who completed the
task this way. Obv. : Benchmark Mean Number of

_ Path Errors

o A common “attempted completion” VITALSO6 VITALSO6
of this task was to click the Record
Vitals button, and add a new record. 8.00 1
Augmenting an existing record could
be an alternate solution, but testers 6.00 0.8
forgot to back-date the record, making 0.6
the task a failure. 4.00 04 -

« L 2.00 - |

o Tester P2-05: “The only option is 0.2
Record Vitals...Ah, I think I found it. 0.00 - 0 -

I am not seeing an easy way to edit. GroupA Group B GroupA  Group B
I can add, but not edit easily. There
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is no edit option visible. In the table
view, I can see the dates and I can see
the list, but I cannot select to edit”

Tester P2-06: “I see what the comments
are, but I don’t see where I can record
comments.”

To navigate to a detail page, testers
would frequently click title in the
middle section of all vitals (e.g.,
Temperature). The “block” then closes,
and testers appear to be surprised.

GROUP B VALIDATION:
Improved

o Successful Completion:
100% increase, from 33% to 66%

o Observed Path:
Benchmark: 39% decrease,
from 2.85 to 1.74

o Error Rate: 0.5, up from 0
RECOMMENDATIONS

o See FIGURE 49D: The high Error Rate
is caused by confusion between the
Submit link, which commits the
comment, and the Close button. Due
to its placement, most users thought
the Close button was the Submit
button. Consider a different treatment,
such as making Submit a button
instead of a link. Also, Close could
save whatever comment was entered.
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ATTEMPTED FIXES

1. From the Vital detail screen (e.g. Weight), when a tester clicks a data point on the chart, show the Record Vitals popup.
Repeat on Table View when user clicks a row. Apply this click-to-edit change to the U1 pattern across the app. Change the
cursor to pointer on hover over a data point. In Edit Record popup, add text area below any existing comment so user can
easily add a comment. Remove “Add Comment” link.

Healthboard Isaac Goodman  Logout {0}

Vital Signs b You have no new measurements. _

— v o EE

All
My Weight

;‘Wd Pressure 1 75 pounds '1 0 pounds 24 4 BMI '1 3 BMI 23-7 BMI

Heart Rate 54 ber 14,2012 from 14,2012 Sef 14,2012 from Augu: 012 Target BM!

Respiratory
— Goal (@ PatientEntry (O ProviderEntry  Reference:
Temperature

Height

Obese Class |

Augll  Sepll  Octll  MNowll Decll  Jan12  Febl12 Mar12  Apri2  May12  Jun12  Jull2  Augl2  Sepl2  Oal2  Novi2

FIGURE 49A: Before: Clicking on a data point makes no action, creating a dead-end
for testers. The cursor remains an arrow, not a pointer (not visible below).

Healthboard IsaacGoodman  Logout {0}
() Vital Signs v You have no new measurements. _m
MY VITALS TimeRange: 1w Im  3m A cuom  [HEE]

All Goal PatientEntry (O Provider Entry

Weight
Blood Pressure Vital Records

Heari rata 66 beats / minute
Heart Rate Entry for 09/14/2012 Edit Delete July 14, 2012
Respiratory Weight is 175 pounds and BMI is 24.4.

Temperature Blood pressure is 120/78 mmHg.

Height

Respiratory Respiratary is 20 breaths/minute. 0 breaths / minute ‘
+ Add Tracker g 14,2012 ‘

Temperature is 103°F.

Heightis 5'11% a

£ Add (
Temperature emments: +Add comment L) 1 0 3 degrees Fahrenhe|

ber 14,2012

Height _— 0 5 feet1 1 inches.

eptember 14, 2012

FIGURE 49AA: Before: Under All, clicking on a data point would reveal the entry.
The user would then have to click Add comment to continue.
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

Health! You have 3 Next Steps ¥ Isasc Goodman  Settings  Logout

VitaISigns ¥ You have no new measurements.
MY VITALS TmeRange Tw Im 3m 1y 3 Al cwom [HE]

All
My Weight

;imd l;l&iiﬂf& 1 75 pounds -1 0 puun-ds 24.4 BMI -1 3 ] 2 3 |7 BMI

Heart Rate ust 14, 201. Goal: BMI

Respiratory

- Goal @ PatientEntry (O Provider Entry Reference: Bod,
Temperature

Height

i1l Augh M Ol MNovll Decll  Jan12  Feb1Z  Marl2  Apri2  MaylZ Juni2 12 Augl2  Sepl2

FIGURE 49B: After: Cursor shows as a pointer (not visible below).
Healthboard You have 3 Next Steps ¥ a Settings  Logout
Vital Signs v You have no new measurements.

MY VITALS Record Time Range:
Al
My Weight
Blood Pressure 1 7 5 Py Vital Records
Heart Rate : Entry for 09/14/2012
Respiratory EE—— Weightis 175 pounds and BM) is 24.4.
) ProviderEntry  Referenc
Temperature Blood pressure is 120/78 mmHg.
Height Respiratary is 20 breaths/minute.

Temperature is 103°F.

Heightis 5'11%

Comments:

Overwsight

Julll Augll  Sepll  Oct]l  Movll Decll  Jan12  Feb12  Marl2  Apri2  May12 12 ki12  Augl2  Sepl2  Oct12

FIGURE 49C: After: When the user clicks, the revised pop-up appears.
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

Healthboard You have 3 Next Steps ¥ a dman  Settings  Logout
Vital Signs v You have no new measurements. _
v viTaLs Tine e 1

All

My Weight
Blood Pressure 1 75 pounds Vital Records
Heart Rate : Entryfor 09/14/2012 Edit Delete

Respiratory B V'sight is 175 pounds and BMI is 24.4.

) ProviderEntry  Referency

Temperature Peasse——  Blood pressure is 120/78 mmHg.
Height Respiratory is 20 breaths/minute.

R——

Heightis 511

Obiess Glass |
Comments:

had the flu
—~ You, Tue Dec 18 15:45:35 GMT-0500 2012

Jull Rugll  Sepll  Octll  Newll Decll  Jnl2  Febi2  Marl2  Apr12  Mayl2 Juni2  Jull2  Augl2  Sepl2  Oa2

FIGURE 49D After: User types a comment, and clicks Submit.
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

PIIMR[ESEARCH

2. For the blocks in the middle of the All vitals section, the arrow should expand and collapse the block, and the text (e.g.
Weight) should go to detail page. Apply this rule wherever this U pattern exists, including the dashboard. For example,
when a user clicks on Blood Pressure from the widget view, it should lead them directly to that page in the module.

¢ Goodman

Healthboard Logout £}

o[
T

@ Provider Entry

You have no new measurements.

1) Vital Signs v

MY VITALS TimeRange: Tw Im  3m 1y 3y Al

+ Record Vitals
All Goal @ PatientEntry
Welght

» Weight Last updat 175 pounds

— —©® 120/78um,

e ®

Blood Pressure
Heart Rate
Respiratory Blood pressure

Temperature

Height

+ Add Tracker

Heart rate

Respiratory

Temperature

Vital Signs v

MY VITALS

You have no new measurements.

ats / minute

\/\(

d \ ¥

You have 3 Next Steps ¥ lsaac Goodman  Settings  Logout

[

v

TimeRange: 1w Im

e I

Al
My Weight

1 75 pounds '1 0

012 ugust 1

24.4 4

September 1

-1 -3 BMI

st 14,2012

Blood Pressure pounds
2

23.7 o

A

Heart Rate s

Respiratory

—— Goal @ PatientEntry (D ProviderEntry  Referenc

Temperature

Height

Otiess Glass |

Julll Augll  Sepll  Octl  Nowll Decll  Janl2 Febi2  Marl2  Apr12  May!2 Junl2  Ji12  Augi2 Sepl2  Oal2

FIGURE 49F: After: In the revision, clicking the text goes to the detail view.
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

VITALS10-11

Where would you view other past comments? VITALS10-11: Mean Scorecard Return
Has your doctor left any comments recently? ’

Group Avs. B
GROUP A DETERMINATION: = Task C lexi Vi | Desi 0 A |
Moderate issues ask Complexity isual Design = Overall Appea
. 7.0
o Task Complexity: 3.8 (4th Worst) 60

o Successful Completion:
67% (Tie, 3rd Worst)

o Observed Time:
Benchmark: 4.61 (Worst)

o Observed Path:
Benchmark: 7.31 (Worst) Group A Group B

o Testers had to spend a lot of time ex-
ploring to find the Comments section.

GROUP B VALIDATION: Mean Success Obv. : Benchmark
Improved VITALS10-11 Time
VITALS10-11
120
o Successful Completion: 5 00
25% increase, from 66% to 83% 100 '
80 4.00 -
o Observed Time: 60 - 3.00 -
Benchmark: 27% decrease,
from 4.61 to 3.38 40 2.00 -
20 - 1.00
o Observed Path:
Benchmark: 15% decrease, 0~ 0.00 -
from 7.31 to 6.18 Group A GroupB Group A Group B
RECOMMENDATIONS
. ' Obv. : Benchmark Mean Number of
. Con&der leaving the comments box Path Errors
open. It is easy to understand when VITALS10-11 VITALS10-11
it is open, plus it is consistent with the
rest of the items in the block. 8.00 1
6.00 - 08
0.6
4.00 -
0.4
2.00 - 0.2
000 - N
Group A GroupB Group A  Group B
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

ATTEMPTED FIXES
p1IM moved the comment block to the top of the All area, but collapsed. Revised block says “14 total comments,
3 provider comments.”

Healthbcard Isaac Goodman  Logout ¥
Vital Signs v  Youhave no new measurements. [seaanmarsons [
MYVITALS TmeRange: w  Im  3m 1y 3y Al cutom [WHIE]

All Goal @ PatientEntry (O Provider Entry

Weight

Blood Pressure
Heart rate 6 6 beats / minute

Heart Rate July 1. 2

Respiratory

Temperature

Helght ‘
2 Respiratory 20 breaths / minute
September 14, 2012
————

Temperature 1 0 3 degrees Fahrenhe|

Height 5 feat 1 1 inches.

September 14, 2012

FIGURE 50A: Before: Comments lived at the bottom of the scrolling area, making them

difficult to find.

Healthboard You have 3 Next Steps ¥ lsaac Goodman  Settings  Logout

[y Vital Signs v You have no new measurements. _m
\.
MY VITALS Tmemange: w m am 1y 3y Al cutom [HHEE]

All Goal (@ PatientEntry () Provider Entry
Weight E =

9 There are 7 comments ®s5 M2 B
Blood Pressure

Heart Rate 1 75 pounds
Respiratory jikeigne, 24.4..
Temperature September 14, 2012

Height

¢ 120/78.m

Blood pressure
September 14, 2012

Heart rate 66 beats / minute

July 14, 2012

Respiratory 20 breaths / minute
September 14, 2012

e 0 @ 103%csendd

FIGURE 508B: After: The new solution moves the Comments to the top, but collapsed.
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PIHMRES[EARCH

VITALS13
Next, you want to review your weight history.
Where would you find details? What is your

THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

VITALS13: Mean Scorecard Return,

weight goal? When were you overweight?
How are you doing now?

GROUP A DETERMINATION:
Minimal issues

o To determine the goal, most users
clicked the Edit Goal button, even
though the information was present
on the screen.

GROUP B VALIDATION:
Indeterminate

o Successful Completion:
33% decrease, from 100% to 66%

RECOMMENDATIONS

o The Goal information may be some-
what of a blind spot. Consider
an alternate treatment. Testers do not
seem to have any trouble finding the
“goal line” from the legend. Perhaps
a rollover on the line displaying the
Goal value would be a meaningful
improvement.

Consider making the Goal (in blue
text) section clickable (3 testers
attempted to click).

L]

If a user rolls over Goal in the legend,
show a tool tip which informs the goal
value.
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Group Avs. B

& Task Complexity

& Visual Design

“ Overall Appeal

7.0

6.0

5.0

3.5

4.0 32
2.5

2.7 2.7

2.8
3.0
2.0
1.0 -
0.0 -

Group A

Group B

Mean Success
VITALS13

120
100 A

40 -
20 -
0~

Group A Group B

Obv. : Benchmark
Time
VITALS13

5.00

4.00

3.00

2.00

o t.:
0.00 -

Group A Group B

Obv. : Benchmark

Path
VITALS13
8.00
6.00
4.00
2.00
oo - mm

Group A Group B

Mean Number of

Errors
VITALS13
1
0.8
0.6
0.4
0.2
Nl B N

Group A  Group B
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

ATTEMPTED FIXES
Change text “Target BM1” to “Goal: BM1”

oodman  Logout L}
Vital Signs v You have no new measurements.

MY VITALS + Record Vials || Time Range: 1w cusom  [E

All
My Weight

Blood Pressure 1 75 pounds = 1 0 pounds 24.4 BMI = 1 -3 BMI 23.7 BMI

I
from August 14, 2012 3 fro 2 Target BMI

Heart Rate =P

Respiratory - Y ! WVWm :Wm m Y
= @ PatientEntry () ProviderEntry  Referenc

Temperature P e,

Height

Ouerweight

e

11 Octll Newll Decll  Jan12  Feb12  Marl2  Apri2  Mayl2  Juni2  Jul12  Augl2  Sepl2  Oal2  Novi2

FIGURE 51A: Before: Reads “Target BM1,” inconsistent with the Edit Goal button.

Healthboar You have 3 Next Steps ¥ codman  Settings  Logout
1) Vital Signs v You have no new measurements.

MY VITALS TmeRange: Tw  Im

All
My Weight

Blood Pressure 1 75 pounds = 0 pounds 24.4 BMI = -3 BMI
s er 14, 2012 fi iqust 1 2 qust 7

1 Aug A

Heart Rate ey

Respiratory

Goal @ PatientEntry (O Provider Entry Reference: Bod

Temperature

Height

Ovecweight

e

Ju1l Augll  Sepll  Oatll  Newll Dec!l  Jan12  Febi2  Marl2  Apr12  May12  Jun12 k12 Augi2  Sepl2  Oal2

FIGURE 51B: After: Reads “Goal: BM1.”
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

PIHMRES[EARCH

VITALS14-15
Change your goal from 170 pounds to 165
pounds.

GROUP A DETERMINATION:
No issues

RECOMMENDATIONS

o Consider making the Goal (in blue
text) section clickable (3 testers
attempted to click).

« If a user rolls over Goal in the legend,
show a tool tip which informs the goal
value.
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VITALS14-15: Mean Scorecard Return,
Group Avs. B

& Task Complexity & Visual Design

“ Overall Appeal

Group A

Group B

Mean Success
VITALS14-15

120
100 A

40 -
20 -

Group A Group B

Obv. : Benchmark

Time
VITALS14-15

5.00

4.00

3.00

2.00

1.00 t.:
0.00 -

Group A Group B

Obv. : Benchmark

Path
VITALS14-15
8.00
6.00
4.00

2.00

o.m W

Group A Group B

Mean Number of

Errors
VITALS14-15
1
0.8
0.6
0.4
0.2
N

Group A  Group B
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PIHMRES[EARCH

EXERO1

Next we're going to think about Exercise.
Active Duty personnel are required to
maintain their physical condition, and must
take regular Physical Readiness Tests. The test
consists of curl-ups, push-ups, and a 1.5 mile
run. Personnel are given a score from Failure
(less than 45 points) to Maximum (100 points).
Based on this, in what area have you most
improved? In what area are you struggling?

GROUP A DETERMINATION:
Minor issues

o Visual Design: 4.0 (Tie, 4th Worst)
o Overall Appeal: 3.7 (2nd Worst)

o Observed Time:
Benchmark: 3.03 (4th Worst)

o Observed Path:
Benchmark: 3.17 (4th Worst)

« Testers appeared to be confused by
the spider chart. All acknowledged
and played with it, but few reported
answers from it.

The excess information—smiling faces,
scores, improvements or declines
indicated with plus/minus symbols
(e.g. +10)—appeared to confuse
people. Tester P2-02: “Oops, it’s
because the number is higher...but
the happy face isn't too happy.” Tester
P2-04: “I'm looking at where it says
+16, +15. I'm thinking those are

the areas I've improved. It looks

like I improved in the 1.5 Mile Run,
and I'm not doing too well with
push-up... wait, if I actually go by the
icons, I'm not doing well in weight
but by points, 'm not doing well in
push-ups”
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:

USABILITY TESTING RESULTS

7.0
6.0
5.0

EXERO1: Mean Scorecard Return,
Group Avs. B

& Task Complexity

& Visual Design

Overall Appeal

4.0

3.7

3.7

Group A

Group B

120
100
80
60
40
20

Mean Success
EXERO1

Group A Group B

Obv. : Benchmark
Time
EXERO1

5.00

4.00
3.00 A
2.00
1.00 -

0.00 -
Group A Group B

Obv. : Benchmark

Path
EXERO1
8.00
6.00
4.00
2.00 -
0.00 -

Group A Group B

Mean Number of

Errors
EXERO1
1
0.8
0.6
0.4
0.2
N

Group A  Group B
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

GROUP B VALIDATION:
Improved

o Successful Completion:
20% increase, from 83% to 100%

o Observed Path:
Benchmark: 23% decrease,
from 3.17 to 2.45

RECOMMENDATIONS

o Add “Last Test (Practice)”:
before the mm/dd/yyyy.

o Testers seemed confused by the com-
ment bubbles in the right column.
Consider removal.
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

ATTEMPTED FIXES

Remove spider chart. Remove timeline. Apply easy to understand gauge graphics representing current measure with
references: bad, good, excellent, etc. Hint at how scoring works. Fix Physician Assigned Exercise information to be
consistent with the Physician Assigned tab.

Healthbacarc aacGoodman  Logout §F

Exercise v You have 3 months il the next PRT. You have 2 Physician-assigned exercises. T

Summary | | Physical ReadinessTest | | Physician Assigned [—

May 3,2012 Physical Readiness Test
Diag ic PRT Test Rest
Average PRT Score Push Ups

6 points
May 3, 2012

Avg. PRT Score

Weight 1.5 Mile Run

1.5 Mile Run Weight

60 5 208 7

Curl Ups

Push Ups Curl Ups 5 points
May 3, 2012

Physician-assigned Personal

Aerobic Exercise: Wall Tennis
4 minutes
May 3, 2012

Strength Training: Quadriceps Extensions
imes (12 repetitions, 3 sets)
z

Eldal You have 3 Next Steps ¥ Isaac Goodman  Seftings  Logout
ype a webpage address, title, or bookmark

Exercise v Your next PRT will be on You have 3 Physician-assigned exercises. _E

[ summary | | Physical Readiness Test | | Physician Assigned |

Physical ReadinessTest  You'einrange 45-49 years oidr Physician-assigned Exercise (2)

May.
Endurance
Overall 92 int: Run / Walk 30
points

PRT Score

34

a3

A& 1smilerun 62 rors

Personal Exercise (1)

=
Bila
A curlups 70 Sl T -

oints
S Bl Ups 5 ga\\slaclary

FIGURE 52B: After: Gauge design included, information refactored.
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

EXERO02B
How much time until your next pRT? EXER02B: Mean Scorecard Return,
Group Avs. B
GROUP A DETERMINATION:
Minimal issues . . .
& Task Complexity & Visual Design = Overall Appeal
o Visual Design: 4.0 (Tie, 4th Worst) 70
6.0

o Overall Appeal: 3.3 (Tie, 3rd Worst)

4.5

o Testers likely rated poorly because
of an “oh silly me” moment, as the
information was front and center
on the screen.

GROUP B VALIDATION:
Revert or Revise Group A Group B

o Observed Time:
Benchmark: 196% increase,

from 1.35 to 4.01
Mean Success Obv. : Benchmark
« Observed Path: EXERO2B Time
Benchmark: 965% increase, from 2.43 120 EXERO2B
to 25.83.: Upon investigation, p11mM
. . 100 5.00
determined this data was actually
a false positive. Tester P2B-10 was 80 - 4.00 -
a “heavy scroller” Each action on the 60 - 300 -
scroll wheel (mouse middle button) '
is counted as part of the user’s path. 40 - 2.00 -
20 - 1.00 -
RECOMMENDATIONS
0 - 0.00 -
« Displaying the time till next PRT GroupA  Group B Group A Group B
(e.g. “3 months”) is likely a more
effective communication.
Obv. : Benchmark Mean Number of
Path Errors
EXERO2B EXER02B
25.00 - 1
20.00 - 0.8
15.00 - 0.6
10.00 - 0.4
5.00 0.2
0.00 - 0 T ]
Group A Group B Group A GroupB
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

ATTEMPTED FIXES
Change to read: “Your next PRT is on mm/dd/yyyy”

lsasc Goodman  Logout ¥

Exercise v You have 3 monthstill the next PRT. You have 2 Physician-assigned exercises. _

| Physician Assigned Personal
Time Range: since [astPRT sincelast2 sincelast3 All Custom !
PassingScore @ PatientEntry (O PRT TestResults
~
Average PRT Score =
1.5 Mile Run Avg. PRT Score 9 2 points
Curl Ups September 24, 2

Push Ups

1.5 Mile Run 6 2 points

14 min. 44
September 24,

70 points.

Curl Ups 40t

Push Ups 24 tim

Sep

FIGURE 53A: Before
Healthboard You have 3 Next Steps ¥ lsaac Goodman  Settings  Logout

Exercise v Your next PRT will be on You have 3 Physician-assigned exercises. ﬂ

+ Record Results Time Range: since lstPRT sincelast2 sincelast3 All custom [IIIIEE]

PassingScore @ PatientEntry () PRT TestResults

All

Average PRT Scare
1.5 Mile Run Overall PRT Score

Curl Ups

Push Ups

1.5 Mile Run 62 points

14 min. 44

Curl Ups

#J~. PushUps

tember 24, 2012

FIGURE 53B: Affer

PIIM RESEARCH P I I M © 2013 PARSONS INSTITUTE
PUBLISHED FEBRUARY 15, 2013 FOR INFORMATION MAPPING

[PAGE 121]



THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

PIHMRES[EARCH

EXERO6, 09
What is your PRT goal for the run?

EXERO06, 09: Mean Scorecard Return,

Group Avs. B
GROUP A DETERMINATION:

Moderate issues

& Task Complexity & Visual Design = Overall Appeal

o Task Complexity: 3.8 (5th Worst)
o Visual Design: 4.3 (2nd Worst)
« Overall Appeal: 3.0 (2nd Worst)

o Successful Completion:
50% (Tie, 2nd Worst)

o Users who successfully completed this
task clicked the Edit Goal button to
get the actual value, which is subopti-
mal considering the information was
on the screen.

Group A

Group B

GROUP B VALIDATION: Mean Success Obv. : Benchmark
Indeterminate EXEROG, 09 Time
EXERO6, 09
120
o Observed Path: = 00
Benchmark: 142% increase, from 1.13 100 ’
to 2.73. Insufficient data for conclusion. 80 4.00
3.00
o Error Rate: 60
0.5, up from 0. This was due to a PIIM 40 - 2.00 -
observer marking failed tasks as errors. 20 - 1.00 -
RECOMMENDATIONS 0~ 0.00 -
Group A Group B Group A Group B

« Consider making the Goal (in blue

text) section clickable (3 testers
attempted to click). Obv. : Benchmark Mean Number of
Path Errors
o If a user rolls over Goal in the legend, EXERO6. 09 EXERO6. 09
show a tool tip which informs the goal ' '
value. 8.00 1
6.00 0.8
0.6
4.00
0.4 -
2.00 - 0.2 -
0.00 - 0 -
Group A Group B Group A GroupB
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

ATTEMPTED FIXES
Change text “Target Points and Time” to “Goal: Points and Time”

Healtht cGoodman Logout LF

Exercise v You have 3 months till the next PRT. You have 2 Physician-assigned exercises. _H

Physician Assigned | | Personal |

Time Range: since lastPRT sincelast2 sincelast3 Al custom [ EE]

My 1.5 Mile Run

Average PRT Score 6 2
points

14 min. 40 sec
Curl Ups Septembe, 012

Push Ups

@ PatientEntry () PRTTestResults  Reference: Standard

Good

Failure

Augll  Sepll Ol  HNovll Jan12  Feb12  Marl2  Apr12  May12  Juni2 12 Augl2  Sepl2  Oal2  Nav12

FIGURE 54A: Before
Healthbcarc You have 3 Next Steps ¥ cGoodman  Settings  Logout

Exercise v Your next PRT will be ol 9, You have 3 Physician-assigned exercises. E

‘ Summary Physical ReadinessTest | | Physician Assigned \ Personal
Time Range: since stPRT sncelast2 sncelast3 All_ Custom

All My 1.5 Mile Run

Average PRT Scy
i\.ren-gs- are 62 points 2 points up 62 points 60 points

14 min. 40 14 min. 40 sec.

Curl Ups Septemb Goal: Points and Time

Push Ups

PatientEntry (O PRT TestResults Reference:

AT Augll o Nov1l Decll Jan12 Feb12  Marl2  Apri2  May12 Jun12  Jullz  Augi2

FIGURE 54B: After
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

EXER10
You nglzlt to challenge yourls§1f bysthe' I;CW EXER10: Mean Scorecard Return,
year. Change your P.RT goal from atisfactory Group A vs. B
to Excellent, which is a time less than or equal
to 11 minutes 30 seconds. . . .
& Task Complexity & Visual Design = Overall Appeal
GROUP A DETERMINATION:
Moderate issues
o Successful Completion:
33% (Tie x3, Worst)
o Error Rate: 0.33 (Tie, 3rd Worst)
o Incomplete tasks were generally
the result of testers failing to set the
Achieve the goal by: calendar option. Group A Group B
GROUP B VALIDATION:
Improved
« Successful Completion: Mean Success Obv. : Benchmark
100% increase, from 33% to 66% EXER10 Time
EXER10
120
« Error Rate: 0.17, down from 0.33
80 4.00
60 3.00
40 - 2.00 -
20 - 1.00 -
0 - 0.00 -
Group A GroupB Group A GroupB
Obv. : Benchmark Mean Number of
Path Errors
EXER10 EXER10
8.00 1
6.00 0.8
0.6
4.00
0.4
0.00 - 0 -
Group A GroupB Group A  Group B
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

PIIMR[ESEARCH

ATTEMPTED FIXES

Eliminate Next PRT as a default choice, force users to make the selection. Calculate the date of the next PrT,
and display it in the option (e.g., Next PrT: 02/02/2013).

Exercise v You have 3 mon

‘ Summary

All My 1.5 Mile Run

62 point]

14 min. 4

Average PRT Score

Curl Ups

|

Push Ups

Satistactoty

Augll  Sepll  Oall

Isaac Goodman

Logout §F

ths till the next PRT. You have 2 Physician-assigned exercises.

Physical ReadinessTest | | Physician Assigned \ Personal

Time Range: since lastPRT sincelast2 sincelast3 Al Custom !

Edit Goal

[] Use the standard goal
60 points

Please set a points target for your 1.5 Mile Run: points 14 min. 30 sec
Median Points and Time

44 Years Male

OR

Plesse st e argetforyour 15 e 1] i [15 ] s
o —

9:45

() PRTTestResults  Reference: Standard  w

15:30

Achieve the goal by:
(®) NextPRT

o) T

.

Dec!l  Jan12  Feb12  Mar12  Apr12 Mayl2 Juni2 Jull2  Augl2 Sepl2 Oal2  Novi2

FIGURE 55A: Before: Has default selected.

Healthbcard

Exercise v

‘ Summary

All My 1.5 Mile Run

Average PRT Score

Curl Ups

Push Ups

Your next PRT will be on

Jl [ Use the standard goal

You have 3 Next Steps ¥ Isasc Goodman  Settings  Logout

You have 3 Physician-assigned exercises.

Physical ReadinessTest | | Physician Assigned | Persanal

Time Range: since [astPRT sincelast2 sincelast3 All Custom !

Edit Goal

60 ;..

14 min. 30 sec.

|
| points

Please set a points target for your 1.5 Mile Run: points . 40

O
45

OR

'y (O PRT TestResults Reference:

min. sec.

9:45

Please set a time target for your 1.5 Mile Run

.-
1530

Good

Achieve the goal by )
() NextPRT

O 12182012

Jul 11

Aug 1l n

Jn12 iz Sepll  Oct12

Apriz

Oct1l  Novll Dec!l  Jani2 Feb12  Marll May 12 Aug 12

FIGURE 55B: After: No default selected, error shown below.

PIIM RESEARCH
PUBLISHED FEBRUARY 15, 2013
[PAGE 125]

PIIM

© 2013 PARSONS INSTITUTE
FOR INFORMATION MAPPING



THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

EXER14, 15
Your doctor has recommended a few exer- EXER14, 15: Mean Scorecard Return,
cises for you. What are they? What reason did Group A vs. B

the doctor provide? How many calories did
you burn on your last exercise? How much

weight have you lost since you started? & Task Complexity & Visual Design Overall Appeal

GROUP A DETERMINATION:
Moderate issues

o Task Complexity: 5.0 (Worst)
« Visual Design: 4.8 (Worst)

o Overall Appeal: 4.7 (Worst)

Group A Group B

o Successful Completion:

50% (Tie, 2nd Worst)

o Observed Time:

Benchmark: 2.89 (5th Worst)
Mean Success Obv. : Benchmark

o Observed Path: EXER14, 15 Time

Benchmark: 4.01 (3rd Worst) 120 EXER14, 15

« In this task, the tester’s perception
of the information was studied. The 80 - 4.00
causation of the poor scorecard marks €0 3.00
may result from the absence of clear
answers; a sense of completion. 40 - 2.00

20 1.00 -
If a participant failed to answer all
the questions correctly, the task was 0 - 0.00 -
marked as incomplete. Not finding GroupA  Group B GroupA Group B

the correct page was the reason testers

failed this task.
o Obv. : Benchmark Mean Number of
D'esplt? being the same layoqt as Path Errors

Vital Signs, testers did not think to EXER14, 15 EXER14, 15
click on Run / Walk and Bike in the
left column. This could be because it 8.00 1
is a shorter list, or perhaps the absence
of an Add Tracker button draws less 6.00

attention to it. 0.6
4,00
0.4

L]

0.8

Instead, testers would click on Run

L]

/ Walk and Bike links in the middle 2.00 1 0.2

section, with the expectation of going 0.00 - 0 1J_,_._,
to the detail page. The block would Group A Group B GroupA  Group B
collapse, leading to confusion.
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

GROUP B VALIDATION:
Improved

o Task Complexity:
43% decrease, from 5.0 to 3.5

« Visual Design:
45% decrease, from 4.8 to 3.3

« Overall Appeal:
42% decrease, from 4.7 to 3.7

o Successful Completion:
67% increase, from 50% to 83%

o Observed Time:
Benchmark: 35% decrease, from
2.89 to 1.87, indicating testers had
a much easier time finding the
information.

o Observed Path: Benchmark:
22% decrease, from 4.01 to 3.15

RECOMMENDATIONS
« The Physician Assigned and Personal

exercises on the Summary tab should
link their respective detail pages.
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

ATTEMPTED FIXES
Putting the expand-and-collapse action on the down arrow, and setting the text (e.g., Run/Walk) as a link to the detail
page would eliminate a lot of confusion.

Isaac Goodman  Logout  {GF

TimeRange: 1d 1w 1m 3m 1y 3y All Custom

—— Goal @ PatientEntry

Run /Walk » Run/Walk Lastupdated Augu 30 minutes

v oFf Bike —-:7‘_—_—_—-—'—._@ 34 minutes

August 3,2012

Bike

FIGURE 56A: Before: Clicking on the text would collapse the section.
Healthboard You have 3 Next Steps ¥ lsaac Goodman  Settings  Logout

Exercise v Your next PRT will be on M You have 3 Physician-assigned exercises. ﬂ
Summary || Physical ReadinessTest | | Physician Assigned nal |

+ Record Results TimeRange: 1d 1w Im 3m 1y 3y All Custom !
Endurance Endurance: Run / Walk

s s Dr.Berg | Startir e January 25, 2011

Run /¥ s for A ment: Weight control of the Assignment: Lose 18 pounds in 6 months
Bike ion: Walk everyday for more than 30 minutes with target heart rate, 120 beats/min.

leart Rate: Weight

3 miles 30 min. 6 m‘l\es/hl A 1 2 0 heats.;m\n 1 80 pounds

August August st August | Augusts, Aug

@ PatientEntry Data: Duration

Nov 11 2 Apri12 May 12 Jun 12 Jul 12 Aug 12

Total Duration: Tota ed:

2'844 min. 1 3 503 cal.

Total e

248 m;\es

an. 25, 2011

FIGURE 56B: After: Clicking on the test goes to the detailed view.
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

EXER11
Record that you walked 2 miles in 45 minutes EXER11: Mean Scorecard Return,
yesterday, and cycled 10 miles for 90 minutes
Group Avs. B
the day before (two days ago).
GROUP A DETERMINATION: & Task Complexity & Visual Design = Overall Appeal
Moderate issues
o Successful Completion:
50% (Tie, 2nd Worst)
o Error Rate: 0.67 (Worst)
o Overall Appeal: 4.7 (Worst)
o The task required users to make two
entries: one for yesterday, the other Group A Group B
for 2 days ago. Testers failed because
they put in a single entry, ignoring the
Date issue.
GROUP B VALIDATION: Mean Success Obv. : B-enchmark
Improved EXERIL Time
EXER11
120
o Successful Completion: 5 00
33% increase, from 50% to 67% 100 '
30 4.00
o Observed Time: . €0 3.00
Benchmark: 37% increase, from 1.56
to 2.14, perhaps because more testers 40 - 2.00 1
were able to successfully complete the 20 - 1.00
task.
0 - 0.00 -
« Observed Path: Group A Group B Group A GroupB
Benchmark: 33% increase, from 1.45
to 1.92, again, perhaps because more
testers were able to successfully com- Obv. : Benchmark Mean Number of
plete the task. Path Errors
EXER11 EXER11
o Error Rate: 0.33, down from 0.67
8.00 1
6.00 0.8
0.6 -
4.00
0.4 -
200 +——mwm 0.2 -
0.00 1LL 0 -
Group A Group B Group A  Group B
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

ATTEMPTED FIXES
piiM moved the date selection to the top of the popup for added attention.

Isaac Goodman  Logout ¥

Exercise v You have 3 months till the next PRT. You have 2 Physician-assigned exercises. _ﬂ

Record Results 1d 1w 1m 3m ly 3y Al Custom -

You can manually record results: Gosl @ PatientEntry

Endurance
Run /Walk: l:| minutes
Run / Walk » Run/walk Lo 30 minutes

e [ e
v OF(S Bike Bike: l:| minutes S 34 minutes
l:l i August 3, 2012

Date collected: | 12/18/2012 «

OR

Import data from your device. Browse file >

FIGURE 57A: Before
You have 3 Next Steps ¥ lsaacGoodman  Settings  Logout

. You have 3 Physician-assigned exercises. _ﬂ

Record Results 1w Im 3m oty 3y Al cusom JIEE]

You can manually record results ’
Endurance: Run / Wal

Dr. Be:
Ko “ 12/18/2012
s Dire Walk everyd|
Run /Walk: l:| minutes

Endurance

Run / Walk

t
3 miles :I 1 20 beats/min 1 80 pounds
August 3, 2012 A . l:l rinites: August 3, 2012 August 3, 2012

—3 (|

Goal @ PatientEntry  Data: Durstion

Comments:

Browse file >

Jun 12 Aug12

Total Distance: Total Du

p

orie:

Total Weight

'811';!\&: 2'844 min. 1 3,503 cal. - 1 1 puunds‘

lan. 25, 2011 25,201

Since Jan. 25, 2011

FIGURE 57B: Affer
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

NUTRO7-09
Speaking of calories, tell me about your NUTRO07-09: Mean Scorecard Return,
food plan. What should you be eating? What Group A vs. B

should you avoid? What's the reason for this
plan? How many calories a day should you
have?

& Task Complexity & Visual Design Overall Appeal

GROUP A DETERMINATION:
Minimal issues

o Testers would click through to
Educational Resources module, feel
a bit lost, and have to navigate back
to Nutrition via the homescreen.

o Testers commented the photos of

foods to take/avoid are small and Group A Group B
difficult to decipher.
o Tester P2-02 thought the 1,700
calories listed under Total Calories
in the middle column was her calorie Mean Success Obv. : B.enChmark
budget. NUTR07-09 Time
NUTR07-09
120
GROUP B VALIDATION: 5.00
Indeterminate 100 '
80 - 4.00
o Task Complexity: 60 - 3.00
15% decrease, from 3.3 to 2.8
40 - 2.00 -
« Visual Design: 20 - 1.00 -
23% increase, from 3.0 to 3.7
0 0.00 -
« Overall Appeal: Group A Group B Group A Group B
19% increase, from 2.7 to 3.2
+ Successful Completion: Obv. : Benchmark Mean Number of
0,
83%, No Change Path Errors
NUTRO7-09 NUTRO7-09
o Observed Time:
Benchmark: 16% increase, 8.00 1
from 2.03 to 2.35
6.00 0-8
o Observed Path: 0.6
Benchmark: 40% increase, from 1.39 4.00 04
to 1.94, this may have been caused 200 1 '
by Tester PB2-10’s heavy use of the ' 0.2 1
mouse scroll wheel. 0.00 - 0 -
Group A Group B Group A  Group B
« Error Rate: 0.33, up from 0.17
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

PIIMR[ESEARCH

ATTEMPTED FIXES
1. Eliminate the Summary tab, and have only My Food Journal (default) and My Food Plan tabs. Refactoring to the design
to eliminate redundant information.

Isaac Goodman  Logout ¥

Healthboard

You have no new notifications

(1T) Nutrition v
e

| summary | [ MyFood Plan [ MyFood Journal |

December 18,2012

Record a Meal (7]

T D

grilled cheese with tomaro Fruits:
- = ENR
b =

My Food Journal MyFood Plan

My Goal is to:

Low-fat or fat

Meat, poultry and fish:

Nuts, seeds & dry be:
W Fats and oils: 2-3 dail
B Sweets: limitto ess

5 daily servings

Enter when, where. and why you had the meal

5 servings per week

What can | eat?

Remember, get most of calories from fruits,
vegetables and starches.

1200 1600 2000 cals.

Record Water Intake

My Health Focus

Did you take your | s today?
L ate: Today - 0845 am

Did you exercise toclay? Log your Exercise

Checkor view your weight in

FIGURE 58A: Before: Shows the Summary tab with a lot of the same information as the
two other tabs.

Healthb

You have 3 Next Steps ¥ saac Goodman  Settings  Logout

Nutrition v You have no new notifications

" My Food Journal | | My Food Plan

December 18,2012

B —— ] |

Record a Meal @ Your Meal List

Type Food Portion
Breakfast 1 cups
Breakfast 1cups

Breakfast | grilled cheese sandwi... 1

Total Calories Taken

1700 cals.

Tl +1700 Cals.Taken
# -0 Cals. Burned

+1700 Total Calories Taken

Cals. From Fats & Qils
Cals. From Sugar

(Cals. From Alcohol

Calories from Extra

Daily Budget: 2,000 Calories

Calories Comments Favorite
123
123

123

Your Food Plate

FIGURE 58B: After: Shows the My Food Journal tab as the default tab, along with the
re-factored layout. See additional attempted fixed below for more color.
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

2. User should enter food, then see it appear in the adjacent table. Remove the Record Food Journal button.

Isaac Goodman  Logout ¥

Exercise v You have 3 months till the next PRT. You have 2 Physician-assigned exercises. _ﬂ

Summary | | Physical Readiness Test

Record Results 1d 1w 1m 3m ly 3y All Custom -

You can manually record results: el

Endurance
Run /Walk: minutes
Run /Walk » Run/walk La it l:lmw 30 minutes

e

v o sike de [ e 34
l:l s August 3, 2012

Date collected: | 12/18/2012

OR

Import data from your device, Browse file >

e

FIGURE 59A: Before: A user would enter food into the Record a Meal form...
Healthbcarc You have 3 Next Steps ¥ lsasc Goodman  Settings  Logout

3. Youhave 3 Physician-assigned exercises.

Record Results 1d 1w Im 3m 1y 3y Al Custom !

You can manually record results ’
Endurance

Run / Walk Re 1 X . « 12182012 | 5

Bike

Run /Walk: minutes
rt R

3 -ml\es 1 2‘0 beats/min 1 8‘0 pounds

August 3, 2012 A August 3, 2012 Augusi 12

Goal @ PatientEntry Data: Duration

0

Browse file >

May 12 Jun 12 Aug12

Tot: ance: 1 D urned

k48 miles 727' 4“4 3,503 cal. 82 V 1 1 pounds

5 lan. 25, 2011 e Ji 5 11 lan. 25, 2011 Since Jan. 25, 2011

FIGURE 59B: Before: ...and it would appear on the bottom of the My Food Journal tab.
PIIM found that after entering a meal, most users went looking for their entry to make
sure it was saved.
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

You have 3 Next Steps ¥ IlsaacGoodman  Settings  Logout

Nutrition v You have no new notifications _B

‘ My Food Journal | | MyFood Plan

[ por | R —— | |

December 19, 2012

Record a Meal @ Your Meal List

l R n Type Food Portion Calories Comments Favorite

Dinner | Spaghetti and meatb... 1plate | 450 late too much. Felt like | was having a heartat

Breakfast | grilled cheeesa sand... 1cups 123

Total Calories Taken Your Food Plate
‘ 532 cals.
Daily Budget: 2,000 Calories

Cals. Taken

Record Water Intake Cals. Burned

Total Calories Taken
Cals. From Fats & Oils

Cals. From Sugar
Cals. From Alcohol

Calories from Extra

FIGURE 59C: After: Entered meals appear directly next to the form.
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USABILITY TESTING RESULTS

PIIMR[ESEARCH

3. Add “title text” on rollover of photos in My Food Plan (e.g. “Fried Foods”).

Healthboard Isasc Goodman  Logout £}

L |0 Nutrition v You have no new notifications
\.

Summary | | MyFood P

Print My Food Plan Download Worksheet

ood to Increase

22 A i
S R

L=

Notes from My Doctors
Dr. Berg

History Suggested Meals for a Day

Try to avold any salty food to decrease sodium. 1)3/4 cub bran flakes cereal:

Recommendation: Nutrition Worl

- Start the day with a whole grain cereal ~ wheat flakes,
toasted Ofs, or oatmeal are some examples.

2) 1 slice whole wheat bread;
1tsp soft (tub) margarine; and

Recommendation: der 1 cup orange juice

3) 1slice French whole gi
1 medium egg (for French to;
1 teaspoon oil.

You have 3 Next Steps ¥ lsaacGoodman  Seftings  Logout

Nutrition v You have no new notifications

n 2 drinks

Food to Increase 22 Food to Limit v

o -
e 8 PP
o I

Notes from My Doctors Suggested Meals for a Day

LA Breakfast

Try to avoid any salty food to decrease sodium. 1)3/4 cub bran flakes cereal:

mpleted
Recommendation: Nutrition Workshop

- Start the day with a whole grain cereal - wheat flakes,
toasted O's, or oatmeal are some examples.
Recommend;

2) 1 slice whole wheat bread;
1tsp soft (tub) margarine; and
1 cup orange juice

Mark completed
Remove
minder

3) 1 slice French toast; whole grain:

1 teaspoon oil.

FIGURE 60B: After: A “title text” appears offer that this photo is “Fried Chicken.”
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

4. Remove the yellow area on bar graphs. Improve communication around 1,700 calories consumed.

Healthbaoarc isaacGoodman  Logout {F

Nutrition v You have no new notifications N

Summary | | MyFoodPlan | | MyFood Journal

December 18, 2012

Record a Meal My Food Journal My Food Plan

dally servings
Vegetables: 45 daily servings
Fruits: 4-5 di rvings
Low-fat or fat-free dai daily servings
Meat, poultry and fis 5 dally servings
Nuts, seeds & dry be ervings per week
W Fatsand oils: 2.3 daily servings
W Sweets: limit to Jes: 1 5 servings per week

What can | eat?

1600 2000 cals. Remember, get most of calories from fruits,
vegetables and starches.

Record Water Intake

s today?

Did you exercise toclay? Log your

Check or view your weight in ¥

FIGURE 61A: Before: Testers were confused by the “Total Calories: 1,700 calories” text.
Testers also failed to recognize the yellow color in the bar graphs indicates caution.

Healthboard You have 3 Next Steps ¥ lsaac Goodman  Settings  Logout

(7T) Nutrition v Youhave no new notifications _ﬂ
N

‘ My Food Journal | | My Food Plan
[ pire.. T |
December 19, 2012

Record a Meal @ Your Meal List

n i n Type Food 4 Portion Calories Comments Favorite
;

Dinner | Spaghett and meatb... 1 plate | 450 I ate too much. Feltlike | was having a heart

Dinner Tuna Noodle Casserole 1ecups

Total Calories Taken Your Food Plate
“ 1700 cais.
Daily Budget: 2,000 Calories

fI +1700 Cals.Taken

Record Water Intake ¥ -0 Cals.Burned

41700 Total Calories Taken

Cals. From Fats & Oils
Cals. From Sugar

Cals. From Alcohol

Calories from Extra

FIGURE 61B: After: PIIM refactored the design to improve the content communication.
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

NUTR18
How have you been doing on your Food Plan NUTR18: Mean Scorecard Return,
over the last week? Over the last month? Did Group A vs. B

you ever exceed your calorie budget? What
nutritional recommendations did you fail to
follow?

& Task Complexity & Visual Design Overall Appeal

GROUP A DETERMINATION:
Moderate issues

o Successful Completion:
67% (Tie, 3rd Worst)

o Testers did not have any issues finding
the reporting, adjusting the dates, or
interpreting the information.

Group A Group B
o Tasks were marked as incomplete
because of failure to answer the last
question regarding nutritional recom-
mendations. Testers had difficulty
identifying or understanding the indi- Mean Success Obv.: B.enChmark
cators for Sodium, Fats & Oils, Sugars, NUTR18 Time
NUTR18
Alcohol and Water. 120
GROUP B VALIDATION: 100 >.00
Improved 80 - 4.00
) 60 - 3.00
o Successful Completion:
25% increase, from 67% to 83% 40 - 2.00
20 - 1.00 -
o Observed Time:
Benchmark: 44% increase, 0 - 0.00 -
from 1.77 to 2.56 Group A GroupB Group A Group B
o Observed Path:
Benchmar.k: 103% increase, from 1.32 Obv. : Benchmark Mean Number of
to 2.69, this may )have been caused Path Errors
by Tester PB2-10’s heavy use of the NUTR18 NUTR18
mouse scroll wheel.
8.00 1
« Error Rate: 0, down from 0.17 0.8
6.00 )
0.6
4.00
0.4
2.00 0.2
0.00 - 0 1J—v—v
Group A GroupB Group A  Group B
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

ATTEMPTED FIXES
Redesign the indicators to improve the communication. Instead of turning red, perhaps indicate by how much
the recommendation was exceed. Consider using the bar graph in other part of the module.

Healthboard isoac Goodman  Logout ¥

(1T) Nutrition v You have ne new notifications N
=
[ MyFood Plan | [ MyFood Journal

+ Record Food Journal m TimeRange: 1d 1w 1m 3m Custom nm -

My Plate Total Calories

Daily Calorie Budget: 2 I
[ 400 200 1200 1600 2000 cas.
4.5
3 fI  +1700 calories consumed
3 -0 calories burned
i Total calories
maximum 3
: B +1700 crincaiocay

Sodium Fats & Qils Sugars Alcohol
= n

P I

2,000 mg. 2-3 2-3 more than 0 cups
servings servings 3 drinks

What | Have Eaten Today

Meal Portion Calories  Date Comments
Breakfast | 1 piece ach quiche
Dinner 1 plate Spaghetti and meatballs 5 Iate too much. Felt like | was having a heart attack!

Breakfast | 1cups | grilled cheese with tomato

FIGURE 62A: Before: The icons “fill up” and turn red when a user exceeds the recom-
mendation.

Healthboarc You have 3 Next Steps ¥ saacGoodman  Settings  Logout

Nutrition v You have no new notifications [ scaciamen 100

[ My Food Journal | | My Food Plan
| Pt | Time Range: 1d 1w tm 3m custom B [N I
December 15,2012
Record a Meal @ Your Meal List
Type Food - Portion Calofies Comments Favorite
Dinner | Spaghetti and meatb... 1 plate | 450 I ate too much. Feltlike I was having a heart
Breakfast Spinach quiche 1 piece | 342

Dinner | Tuna Noodle Casserole 1 cups

Total Calories Taken Your Food Plate
“ 1700 cals.
Daily Budget: 2,000 Calories

fl +1700 Cals.Taken
v -0 Cals.Burned

+1700 Total Calories Taken

Cals. From Fats & Qils
Cals. From Sugar

Cals. From Alcohol

Calories from Extra

FIGURE 62B: After: PIIM used a bar chart to communicate status and overages.
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

NUTR15
What did you eat for breakfast today? How do NUTR15: Mean Scorecard Return
you find nutritional information on it? Group A vs. B ’
GROUP A DETERMINATION: ) i i
& Task Complexity & Visual Design = Overall Appeal

Minimal issues

o Testers had a minor issue discover-
ing the location of the food journal
(indicated by higher-than-normal
Observed Path: Benchmark of 2.29)
as it's on the bottom of the screen
and partially off-screen.

« Nutritional information was shown
on hover, which “flickered” and frus-

trated some testers. Group A Group B
o Impressively, testers realized it was
necessary to change the date to “1d”
RECOMMENDATIONS Mean Success Obv. : Benchmark
NUTR15 Time
o Make the help icon available on-click, 120 NUTR15
provide a way to close it. Most testers
who successfully completed the task
attempted to first click on the infor- 80 - 4.00
mation icon. 60 - 3.00
« To find information on past meals, 40 - 2.00
3 testers clicked on the View History 20 - 1.00 -
link on My Food Plan tab and even
in the Notes from My Doctor section. 0 - 0.00 -
Consider removing these links. GroupA  Group B GroupA  Group B
Obv. : Benchmark Mean Number of
Path Errors
NUTR15 NUTR15
8.00 1
6.00 0-8
0.6
4.00 -
0.4
2.00 A 0.2
000 - N .
Group A Group B Group A GroupB
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NUTRO6
Report that you consumed 5 cups of water
today.

GROUP A DETERMINATION:
Minimal issues

o Most participants attempted to solve
this by clicking on the Water indicator
on the My Food Journal page.

« Some users expected a Save button to
commit the water section.

PIIM RESEARCH
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NUTRO06: Mean Scorecard Return,
Group Avs. B

& Task Complexity & Visual Design = Overall Appeal

2.8

Group A Group B
Mean Success Obv. : Benchmark
NUTRO6 Time
120 NUTRO6
100 - 5.00
80 - 4.00
60 - 3.00
40 - 2.00 A
20 - 1.00 -
0 - 0.00 -
Group A GroupB Group A Group B
Obv. : Benchmark Mean Number of
Path Errors
NUTRO6 NUTRO6
8.00 1
6.00 03
0.6
4.00
0.4
2.00 0.2
0.00 1LL 0 1J—v—v
Group A GroupB Group A  Group B
P I I M © 2013 PARSONS INSTITUTE
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NUTRO4

HealtBoard allows you to save frequent meals
for quick entry. You eat a peanut butter

and jelly sandwich for a snack at least once

a week, and have saved it. Record you ate a
peanut butter and jelly sandwich for a snack
today.

GROUP A DETERMINATION:
No issues

NOTE
See recommendations under task NUTRO1.

PIIM RESEARCH
PUBLISHED FEBRUARY 15, 2013
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:

USABILITY TESTING RESULTS

NUTRO04: Mean Scorecard Return,
Group Avs. B

& Task Complexity

& Visual Design

“ Overall Appeal

7.0

6.0

5.0

4.0

2.8

3.0 22730

1.8 2.0

20

Group A

0.0 =

Group B

Mean Success
NUTRO4

120
100

40 -
20 -

0~
Group A Group B

Obv. : Benchmark
Time
NUTRO4

5.00

4.00

3.00
2.00 -
1.00

0.00 -
Group A Group B

Obv. : Benchmark

Path
NUTRO4
8.00
6.00
4.00

0.00 -

Group A Group B

Mean Number of

Errors
NUTRO4
1
0.8
0.6
0.4
0.2
Nl B N

Group A  Group B
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PIHMRES[EARCH

NUTR16

Say you've already entered today’s dinner into
HealthBoard. It's something you eat frequent-
ly. Save it for quick entry.

GROUP A DETERMINATION:
Moderate issues

o Successful Completion:
50% (Tie, 2nd Worst)

o Error Rate: 0.33 (Tie, 3rd Worst)

« Some testers had issues locating
or understanding the idea of saving
a meal.

GROUP B VALIDATION:
Improved

o Successful Completion:
67% increase, from 50% to 83%

o Observed Time:
Benchmark: 88% increase,
from 1.15 to 2.16

o Observed Path:
Benchmark: 103% increase, from 0.72
to 2.22 this may have been caused
by Tester PB2-10’s heavy use of the
mouse scroll wheel.

o Error Rate: 0.17, down from 0.33
RECOMMENDATIONS

« No improvement on the time and
path. Consider removing the unnec-
essary prompt after saving: “Are you
sure you want to save this meal?”

« Consider moving the Favorites
column to the left side of the table,
making for a slightly more natural
position and proximity to the entry
form.

PIIM RESEARCH
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:

USABILITY TESTING RESULTS

NUTR16: Mean Scorecard Return,
Group Avs. B

& Task Complexity

& Visual Design

Overall Appeal

7.0

6.0

5.0

4.0

2.8

3.0 20 22

17 20

2.0

0.0 =

Group B

Mean Success
NUTR16

120
100

60
40 -
20 -

0 -
Group A Group B

Obv. : Benchmark
Time
NUTR16

5.00

4.00

3.00
2.00 -
1.00

0.00 -
Group A Group B

Obv. : Benchmark

Path
NUTR16
8.00
6.00
4.00

0.00 -

Group A Group B

Mean Number of

Errors
NUTR16
1
0.8
0.6
0.4
0 -

Group A  Group B
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

ATTEMPTED FIXES
1. Remove Health Focus block, as it has little value and adds noise

IsaacGoodman  Logout ¥

Nutrition v You have no new notifications e

Summary | | MyFoodPlan | | MyFaod Journal

December 18,2012

Record a Meal (7] Food Journal My Food Plan

[T prr—— My sl
laily servings.

Search i dally servings
Low-fat or fat-free dairy: 27 daily servings
daily servings
servings per week
rvings
than 5 servings per week

dally servings

What can | eat?

Remember, get most of calories from fruits,
vegetables and starches.

Record Water Intake

My Health Focus
Did you take your /

Did you exercise today? Log your

Check or view your weight in

FIGURE 63A: Before: The arrow indicates the Health Focus block.

Healthboard You have 3 Next Steps ¥ Isaac Goodman  Settings  Logout

(1Y) Nutrition v You have no new notifications _ﬂ

My Food Journal | | My Food Plan

[ e ——T | |

December 19,2012

Record a Meal @ Your Meal List
n Adcla foritameal n Type Food i Calories Comments Favorite
. Dinner | Spaghetti and meatb. 1plate | 450 I ate too much. Felt like | was having a heart
Breakfast | Spinach quiche 1 piece

Dinner | Tuna Noodle Casserole 1 cups

Total Calories Taken Your Food Plate
& 1700 cals.
Daily Budget: 2,000 Calories

Tl +1700 Cals.Taken

Record Water Intake z -0 Cals.Buned

+1700 Total Calories Taken

Cals. From Fats & Oils
Cals. From Sugar

Cals. From Alcohol

Calories from Extra

FIGURE 63B: After: The refactored design removes the Health Focus block.
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

2. Instead of having a Save function, instead use a star to “favorite” a meal.

Healthboa isoac Goodman  Logout ¥

Nutrition v You have ne new notifications N

o ——

Total Calories
Daily Calorie Budget: 2

[ 400 200 1600 2000 cas.
3 fI  +1700 calories consumed
= A -0 calories bumed
maximum 3 + 1 700 Total calories
serving servings consumed today

Sodium Fats & Qils Sugars Alcohol ‘Water Calories from Extras 5, and alcohol
e from extras.

2-3 more than 0 cups
servings servings 3 drinks

What | Have Eaten Today

Meal Portion Calories  Date Comments
Breakfast | 1piece  Spinach quiche 3 12/18/2012
Dinner 1 plate Spaghetti and meatballs 5 12/18/2012 | ate too much. Feltlike | was having a heart attack

Breakfast | 1cups | grilled cheese with tomato

FIGURE 64A: Before: The user would have to mouse-over a row to reveal the Save link.

Healthboard You have 3 Next Steps ¥ lsaac Goodman  Settings  Logout

Nutrition v You have no new notifications _ﬂ

| MyFood Journal | | MyFood Plan
| e | TimeRange: 1d Tw 1m 3m cutom [T IR

December 19,2012

Record a Meal @ Your Meal List

n Add a favorite meal n Type Food 4  Portion Calories Comments Favorite

Dinner Spaghetti and meatb... 1plate | 450 | ate too much. Felt like | was having a heart ¢

Dinner | Tuna Noodle € 1cups

Total Calories Taken Your Food Plate

/Y 1700 cas.
Daily Budget: 2,000 Calories

fl +1700 Cals.Taken

Record Water Intake r -0 Cals.Burned

+1700 Total Calories Taken

Cals. From Fats & Oils
Cals. From Sugar
Cals. From Alcohol

Calories from Extra

FIGURE 64B: After: The favorite column exists on the right. User just clicks the star to

favorite.
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PUBLISHED FEBRUARY 15, 2013 FOR INFORMATION MAPPING

[PAGE 144]



THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

NUTR10
. o
How much sodium should you have daily? NUTR10: Mean Scorecard Return,
Group Avs. B
GROUP A DETERMINATION:
No issues
& Task Complexity & Visual Design = Overall Appeal
7.0
6.0
5.0
4.0
2.5
3.0
1.8 1.7
2.0 t—43—L3
0.0 -
Group A Group B
Mean Success Obv. : Benchmark
NUTR10 Time
NUTR10
120
115 5.00
110 4.00
105 3.00 A
100 - 2.00 A
95 - 1.00 -
90 - 0.00 -
Group A Group B Group A Group B
Obv. : Benchmark Mean Number of
Path Errors
NUTR10 NUTR10
8.00 1
6.00 08
0.6
4.00 -
0.4
2.00 - 0.2
0.00 - 0 T !
Group A Group B Group A  Group B
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PIHMRES[EARCH

NUTR19

Speaking of sodium, does your most recent
blood pressure check indicate any hyperten-

sion (a.k.a. high blood pressure)?

GROUP A DETERMINATION:
No issues

PIIM RESEARCH
PUBLISHED FEBRUARY 15, 2013
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:

USABILITY TESTING RESULTS

VITALS19: Mean Scorecard Return,

Group Avs. B
& Task Complexity & Visual Design = Overall Appeal
7.0
6.0
5.0
4.0
3.0 25 2333 7—23—2.2
2.0 - ——
1.0 —
0.0 ~
Group A Group B
Mean Success Obv. : Benchmark
VITALS19 Time
VITALS19
120
100 - 5.00
80 - 4.00
60 - 3.00
40 - 2.00 A
20 - 1.00 -
0 - 0.00 -
Group A Group B Group A Group B

Obv. : Benchmark

Path
VITALS19
8.00
6.00
4.00

0.00 -

Group A Group B

Mean Number of

Errors
VITALS19

0.8
0.6

0.4
0.2

O T 1
Group A  Group B
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

VITALS20

You s‘moke an occasional cigarette, and want VITALS20: Mean Scorecard Return,
to quit. Add a tracker to help you remember
Group Avs. B

how much you’ve been smoking.

& Task Complexity & Visual Design = Overall Appeal

GROUP A DETERMINATION:
Moderate issues

o Task Complexity: 4.3 (3rd Worst)

o Visual Design: 4.2 (3rd Worst)
o Overall Appeal: 3.3 (Tie, 3rd Worst)

o Successful Completion:
67% (Tie, 3rd Worst)

Group A Group B
o Error Rate: 0.5 (2nd Worst)
o Testers had trouble identifying which
module a Tracker would be in.
Mean Success Obv. : Benchmark
o Labels were confusing to Tester P2-02, VITALS20 Time
and testers were generally confused by 120 VITALS20
the Tracker Entry part of the form.
100 5.00
GROUP B VALIDATION: 80 4.00
Revert or Revised €0 - 3.00 -
o Successful Completion: 40 - 2.00 -
0, 0, 0,
25% decrease, from 67% to 50% 20 - 1.00 -
o Observed Time: 0 - 0.00 -
Benchmark: 116% increase, Group A Group B Group A Group B
from 1.51 to 3.26
+ Observed Path: Obv. : Benchmark Mean Number of
Benchmark: 122% increase,
from 0.91 to 2.02 Path Errors
’ ’ VITALS20 VITALS20
« Error Rate: 0.33, down from 0.5 8.00 1
0.8
RECOMMENDATIONS 6.00
0.6
« Testers did not relate “trackers” to 4.00 04 -
Vital Signs. Consider renaming Vital ] '
Signs, perhaps to Trackers or Vitals 2.00 . 0.2 1
Tracker. 0.00 - 0 -
Group A Group B Group A  Group B
« Consider a different location for P P P P
trackers.
PIIM RESEARCH ©2013 PARSONS INSTITUTE
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

ATTEMPTED FIXES
1. Change the button label from + Add Tracker to + Add New Tracker.

Isaac Goodman  Logout  {GF
Vital Signs v You have no new measurements.

MY VITALS TimeRange: 1w Im  3m 1y 3y Al

All Goal @ PatientEntry (O Provider En
Weight

Blood Pressure
Heart rate 66 beats / minute

Heart Rate July 14, 2012

Respiratory

Temperature

4]
Height ‘
eig] i \/\@ 2 0 breaths / minute
ber 14,2012
———~

Temperature /\—/8 1 03 degrees Fahrenhe|

ember 14, 2012

Height D ————— 5 feet1 1 inches.

ember 14, 2012

FIGURE 65A: Before
Healthboard You have 3 Next Steps ¥ lsaac Goodman  Settings  Logout

I: T Vital Signs v You have no new measurements.
Na

MY VITALS TimeRange: 1w Tm  3m 1y 3y Al
All Goal @ PatientEntry (O Provider Entry
Weight
g There are 7 comments @5 m:2
Blood Pressure

Heart Rate 1 75 pounds
Respiratory Weight 24.4.,

Temperature September 14, 2012

Height

A NRw Tacke Blood pressure 1 20 / 78 Nk

Heart rate 66 beats / minute
July 14,2012

Respiratory 2 0 breaths / minute
September 14, 2012

FIGURE 65B: Affer
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

2. Change the titles and labels of the Add New Tracker creation form. p11m also added the units label after the Result text
box.

lsaac Goodman  Logout 0¥

Vital Signs v You have no new measurements. _ﬂ

MY VITALS TmeRange: Tw Im 3am 1y 3y Al cutom [HN[EE]

Goal @ PatientEntry () Provider Entry
Weight 4]

Blood Pressure S — 66
Heart Rat Y Pt Create Your Own Tracker beats / minute
e July 14,2012

Respiratory Name:

Height -
ol ey I s
September 14, 2012

Tracker Entry

e 103°
Temperature Date: degrees Fahrenhe|

September 14, 2012

Height D —————_———— 5 feet1 1 Inches

September 14, 2012

FIGURE 66A: Before

Healthboard You have 3 Next Steps ¥ lsascGoodman  Settings  Logout

/-

() Vital Signs ¥  Youhave no new measurements. scacnviisgns Q0
\
MYVITALS Time Range: Tw vy A asen [HIE

All Goal @ PatientEntry (O Prowider Entry
Welight

9 There are 7 comments ®s5 2 4]
Blood Pressure

Heart Rate Create Your Own Tracker 1 7 5 pounds

Weight
fl L :l : l:l 4 4
espiratory Tracker name 2 o .
Temperature Unit of Measurement: | cigarsties eg:lbs, % BrTiier . A0F2

Helght _= cigarettes
Blood pressure 1 20/ 78 Ll
rember

Goal:

My First Entry

12/19/2012

Heart rate 66 beats / minute
July 14,2012

Result:

Date:

Respiratory 20 breaths / minute
September 14,

FIGURE 66B: Affer
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

NUTR12
You wor?t always have access to a computer NUTR12: Mean Scorecard Return,
and the internet. Download a worksheet to
) Group Avs. B
og your meals on-the-go.
GROUP A DETERMINATION: & Task Complexity & Visual Design = Overall Appeal
No i
o issues 20
6.0
5.0
4.0
2.2 2 5
3.0 1.8 18 20 17
2.0 —
1.0 —
0.0 ~
Group A Group B
Mean Success Obv. : Benchmark
NUTR12 Time
NUTR12
120
100 - 5.00
80 4.00
60 - 3.00
40 2.00 A
20 - 1.00 -
0 - 0.00 -
Group A Group B Group A Group B
Obv. : Benchmark Mean Number of
Path Errors
NUTR12 NUTR12
8.00 1
6.00 0.8
0.6
4.00
0.4
200 T mmm 0.2
0.00 1J—v—.—v 0 T
Group A GroupB GroupA  GroupB
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

EDUO03, 06
Wher.e would you find information on the EDUO03, 06: Mean Scorecard Return,
occasional heartburn that some foods cause Group A vs. B
you? Bookmark it for future reference. '
GROUP A DETERMINATION: & Task Complexity & Visual Design = Overall Appeal
Moderate issues 70
o 6.0
o Successful Completion:
33% (Tie x3, Worst) 5.0 33
35 _an ©© 35 35
4.0 33
« 50% of testers could not identify the 3.0 - —
correct module. 2.0 - —
1.0 - —
RECOMMENDATIONS
0.0 -
« On the “widget view;” elevate the Group A Group B
position of Educational Resources
so that it is on the screen by default.
Mean Success Obv. : Benchmark
EDUO3, 06 Time
EDUO03.06
120
100 5.00
80 4.00
60 3.00
40 - 2.00 -
20 - 1.00 -
0 - 0.00 -
Group A Group B Group A Group B
Obv. : Benchmark Mean Number of
Path Errors
EDUO3, 06 EDUO03, 06
8.00 1
6.00 0.8
0.6
4.00
0.4 -
2.00 02 -
Group A Group B GroupA  GroupB
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PIHMRES[EARCH

EXERO4
What personal exercises are you doing?

THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:

USABILITY TESTING RESULTS

GROUP A DETERMINATION:
No issues

PIIM RESEARCH
PUBLISHED FEBRUARY 15, 2013
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EXERO4: Mean Scorecard Return,

Group Avs. B
& Task Complexity & Visual Design = Overall Appeal
7.0
6.0
5.0
4.0
2.2 2 5
3.0 17 20 20 %3
2.0 : L5 ——
1.0 —
0.0 -
Group A Group B
Mean Success Obv. : Benchmark
EXER04 Time
EXERO4
120
100 5.00
80 - 4.00
60 - 3.00
40 2.00 A
20 - 1.00 -
0 - 0.00 -

Group A Group B

Group A Group B

Obv. : Benchmark

Mean Number of

Path Errors
EXERO4 EXERO4
8.00 1
6.00 08
0.6
4.00
0.4
2-00 0‘2
ool om R L

Group A Group B

Group A  Group B
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PIHMRES[EARCH

EXER17-18
Add “weight training” as personal exercise.
Add “soccer”

GROUP A DETERMINATION:
Minimal issues

o Error Rate: 0.33 (Tie, 3rd Worst)

« In the Untrackable Exercise form,
Test P2-02, typed her persona name
“Tiffany Janeway” instead of the
Exercise name.

o Most participants were confused by
the distinction between Trackable and
Untrackable exercise. One tester ques-
tioned: “Aren’t all exercises trackable?”

GROUP B VALIDATION:
IMPROVED

o Successful Completion:
20% increase, from 83% to 100%

« Error Rate: 0, down from 0.33

PIIM RESEARCH
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& Task Complexity

EXER17-18: Mean Scorecard Return,
Group Avs. B

& Visual Design

“ Overall Appeal

7.0

6.0

5.0

4.0

25 25

,e 28

3.0
2.0
1.0 -
0.0 -

2.0

Group A

Group B

Mean Success
EXER17-18

120
100 A

40 -
20 -

0~

Group A Group B

Obv. : Benchmark
Time
EXER17-18

5.00

4.00

3.00

2.00

0.00 -

Group A Group B

Obv. : Benchmark

8.00

6.00

4.00

2.00

0.00

Path
EXER17-18

. - -

Group A Group B

Mean Number of

Errors
EXER17-18
1
0.8
0.6
0.4
0 -

Group A  Group B
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

ATTEMPTED FIXES
1. Eliminated the Trackable versus Untrackable distinction. The form, formerly known as Untrackable,
becomes an Other option.

IsaacGoodman  Logout ¥

Exercise v You have 3 months till the next PRT. You have 2 Physician-assigned exercises.

Summary Readiness Test Physician Personal
Tmeange: 14w Im 3m 1y 3 Al Cusom [

—— Goal @ PatientEntry
Bike

Hike

_—@ 34 min

X OFO. 4 What would you like to add?

utes
2

(®) Trackable Exercise ? A +runwalk

(O Untrackable Exercise (@ o8 +Bike
22 4 swim
&+ Hliptical Machine
& +voga

Y+ weightTraining

”

FIGURE 67A: Before: User just choose between Trackable and Untrackable exercise,
which confused testers.

Healthboard You have 3 Next Steps ¥ lsaac Goodman  Settings  Logout

Exercise v Your next PRT will be on March 20, 2013. You have 3 Physician-assigned exercises. ﬂ

Summary Physical Readiness Test | | Physician Assigned Personal
+Add TimeRange: 1d 1w Im 3m 1y 3y All Custom _

Goal @ PatientEntry
Comments

Bike There are 5 comments ®s5 o

Hike
What would you like to add? @
A e 34 s

A +runwalk August 3, 2012
o8 +Bike
=&+ Swim

B +Elliptical Machine

&, +Yoga
T + Weight Training
+Others

FIGURE 67B: After: User just chooses an exercise, and Untrackable exercise becomes

Other.
PIIM RESEARCH P I I M © 2013 PARSONS INSTITUTE
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

2. Change the Name default text to be Exercise Name.
Healthba: IsaacGoodman  Logout §F
Exercise v You have 3 months till the next PRT. You have 2 Physician-assigned exercises.

TimeRange: 1d 1w 1m 3m 1y 3y All Custom !

—— Goal @ Patient Entry

3 4 minutes

August 3, 2012

‘What would you like to add?

@ Untrackable Exercise PRy

FIGURE 68A: Before
Healthbc You have 3 Next Steps ¥ lsasc Goodman  Settings  Logout

Exercise v Your next PRT will be on March 20, 2013. You have 3 Physician-assigned exercises. _E

e
TimeRange: 1d 1w 1m 3m 1y 3y All Custom !

Goal @ PatlentEntry
Comments.

B Cor There are 5 comments ®s5 o

Hike
What would you like to add? @
— 3 4 minutes

Notes: | Tz

FIGURE 68B: Affer
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USABILITY TESTING RESULTS

Exit Survey Results: Group 1

PIIM RESEARCH P I I M © 2013 PARSONS INSTITUTE
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

2. ON THE SCALE BELOW, HOW EASY OR DIFFICULT DID YOU FIND USING THE SOFTWARE?

GROUP 1A

2 (1) Very
unlikely.

(7) Very 6 5 4 3
Likely

GROUP 1B

(1) Very
unlikely.

(7) Very 6 5 4 3 2
Likely

3. WHAT PART OF THE TESTING DID YOU FIND WAS THE MOST CHALLENGING?

GROUP 1A

“...Most challenging were the
navigation aspects that were unlike
either Windows or Mac.”

“Getting used to navigating”

“Couldn’t figure out one task at all, and was also confused
by the password changing task. Most challenging were the
navigation aspects that were unlike either Windows or Mac.”

“Finding where to click to record additional information
about medications, and figuring out which of the available
appointment slots was actually applicable.”

“Not being able to take my own notes. I think I would have
been able to offer better comments, if I could take a quick
note on each of the scorecards.”

“learning all of the bits of the software/program”

“Locating how to change notifications...I just didn’t see the
‘cog’ even though I am familiar with that mechanism for
changing things.”

PIIM RESEARCH
PUBLISHED FEBRUARY 15, 2013
[PAGE 157]

GROUP 1B

“Finding the ‘Next Steps’” information.”

“Date navigation.”

“finding old medications, registering for chair yoga,
perhaps one more thing I can’t remember”

“Recording that I have done something scheduled in the
Next Step.”

“Finding next steps”

“Finding when I took certain medications. Looking at
history of Next Steps. Not sure what Next Steps meant.”

“Finding the ‘Next Steps’ information.”

© 2013 PARSONS INSTITUTE
FOR INFORMATION MAPPING
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

4. WHAT PART OF THE TESTING DID YOU FIND THE EASIEST?

GROUP 1A GROUP 1B

“Most of the information was very “Navigating the main heading
clear. The home screen was easyand  sections”
made sense.”

“The messages module”
“Finding the ‘subject’ needed on the home page” “adjusting settings on the site”

“Most of the information was very clear. The home screen “Finding information on the medical record.”
was easy and made sense.”
“Navigating the main heading sections”
“All of the choices that were available via buttons or tabs
at the top of the screen” “Settings”

“Most of the actions were fairly straight forward, the “Logging in and changing settings”
questions or actions were easy to understand.”

“sending mail, but I use it to send mail really unless I had

2

to

“Messaging and appointments.”

PIIM RESEARCH P I I M © 2013 PARSONS INSTITUTE
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THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

5. WHAT FEATURE OR INFORMATION WAS MOST VALUABLE TO YOU?

GROUP 1A

“Making appointments!”

“The medical history and the
coordination of information between
appointments and suggested next
steps.”

“lab/test results at your fingertips”

“Making appointments, communicating with the medical
personal easily”

“Making appointments!”

“The medical history and the coordination of information
between appointments and suggested next steps”

“my past history, particularly immunizations and
prescription info”

“Appointments and medications. Probably tracking
would have been if I'd been looking at it. (I took a look in
my desperate attempt to locate “notifications””)”

PIIM RESEARCH
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GROUP 1B

“The medication history, and the
data it was pulling on meds, was
surprisingly helpful.”

“...Information that’s organized in a
way that’s relevant and easy to find
and remember.”

“The medication history, and the data it was pulling on
meds, was surprisingly helpful”

“being able to pull up medical records, and also pulling
up drug dosages/when they were prescribed also great to
record exercise, and immunizations”

“Icons with a title that tells me what information I'm
getting when I click on it. Information that’s organized in
a way that’s relevant and easy to find and remember”

“Medication, probably, or the history of appointments and
procedures”

“List view as opposed to horizontal view of medications
taken. List view was more clear and easy to understand.”

“The medical history information”
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6. WHAT FEATURE OR INFORMATION WAS LEAST VALUABLE TO YOU?

GROUP 1A

“Everything seemed valuable.”

“mail and calender system. why
use it I have and love gmail.”

wo»

“Can’t think of anything. Perhaps I'm not sure why I
would have to send my doctor medical records when
I could presumably give her permission to access them.”

« »

n/a

“Everything seemed valuable”

“mail and calender system. why use it T have and love gmail.”

“Nothing wasn’t valuable”
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GROUP 1B

“Depends—didn’t use certain
sections, but probably the ones that
would take the most voluntary time
(daily exercise, food, etc.)”

« »

n/a
“I think it was all valuable”

“Depends—didn’t use certain sections, but probably
the ones that would take the most voluntary time (daily

exercise, food, etc.)”

“Data visualizations”

“The calendar—I keep my own master calendar with all the

information I need on it”
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7. WAS THERE ANYTHING YOU THOUGHT WAS MISSING FROM THE SOFTWARE?

GROUP 1A GROUP 1B

“..In places, | would really have liked “Enabling the user to choose the
acknowledgment that the task had color scheme would be nice...”
been completed.”
“The drop down box for module nav.”
“...awindow or pop-up which '
provide d the most critical “perhaps' a comprehensive lo<?k at c.liet)—but that .rn”ight be
nformation (immunizations there or in the works and we just didn’t work on it
1n
Overdue, next appointment, refill “Enabling the user to choose the color scheme would be

nice. Having the option to choose a sound for notifications

. . »
for medlcatlon)' would also be nice”
“NO”
“Information hidden in the gear icon should be moved to
the middle of screen and given a clear label.” “Diary of side effects”

“I missed back buttons, but I could get used to it. In places,I ~ “No.
would really have liked acknowledgment that the task had
been completed.”

“More explanations about the use of each screen at the top
of each screen”

“Maybe a window or pop-up which provided the most
critical information (immunizations overdue, next
appointment, refill for medication)”

“search”

“I made note as I went along.”
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8. IF THIS SOFTWARE WERE AVAILABLE TO YOU, HOW LIKELY WOULD YOU BE TO USE IT?

GROUP 1A

(7) Very 6 5 4 3 2 (1) Very
Likely unlikely.

COMMENTS

“Convenience and one-stop
shopping”

“Ease of use; found interface
comforting; made me feel as though
I was in control. Dark color scheme
is comforting—not clinical.”
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GROUP 1B

(7) Very 6 5 4 3 2 (1) Very
Likely unlikely.

“It keeps track many of my important
records and any new updates.”

“The interface was difficult although
the concept of the site could be very
useful.”

“It seems to do what I would want it to do.”

“It keeps track many of my important records and any
new updates”

“The interface was difficult although the concept of the
site could be very useful”

“I don’t have very many doctor’s appointments at the
moment, but maybe in the future”

P I I M © 2013 PARSONS INSTITUTE
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9. HOW LIKELY WOULD YOU BE TO RECOMMEND THE SYSTEM TO A FRIEND OR COLLEAGUE?

GROUP 1A GROUP 1B

6 6

5 5

4 4

3 3

2 1 21

1- 17

Ty &5 422 O o
COMMENTS

“Makes it easy to keep all your

o . . ) “I think with continuous use,
medical information/history in

the interface will make sense.”

one place.”
“Simple enough for most people to work through.
“Obviously the concern would be for security, but outside Maybe not my mother, though.”
of that it would be nice to have everything in one place,
especially medical history!” “it is efficient and it’s a great idea to keep all of this

information in an easy to locate place.”

“I'd recommend it to someone that is sick and has lots of

stuff to keep track of” “I think with continuous use, the interface will make
sense.”

“It’s useful to have all your medical information in
one place.”

PIIM RESEARCH P I I M © 2013 PARSONS INSTITUTE
PUBLISHED FEBRUARY 15, 2013 FOR INFORMATION MAPPING
[PAGE 163]



PIIMR[ESEARCH

THE VISUAL DASHBOARD & HEADS-UP DISPLAY OF PATIENT CONDITIONS:
USABILITY TESTING RESULTS

10. DO YOU HAVE ANY OTHER FINAL THOUGHTS OR COMMENTS YOU'D LIKE TO SHARE ABOUT YOUR EXPERIENCE?

GROUP 1A

“I think the strength of a system like
this is in detecting patterns. it would

be great if it told me after a few years:

you tend to have allergies in May, so
start taking allergy medication in
April to ward off the coming effects

»

“Very interesting, glad to have the opportunity to
participate!”

“Although I understand most military personal and their
families are under 40, for those who aren’t (and aren’t
corrected well), the type might be a bit small and the place
to change it wasn’t very obvious. On the whole, it was fun.
Iloathe calling for an appointment.”

“This is a great app and the testers were very welcoming
and accommodating.”

“It was great. Thanks for letting me participate”

“I think the strength of a system like this is in detecting
patterns. it would be great if it told me after a few years:
you tend to have allergies in May, so start taking allergy
medication in April to ward off the coming effects”

“Great user testing and great interface”
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GROUP 1B

“...More options for customization
of the screen would also be nice,
such as the color, where different
categories of information can be
placed on a page on the screen, etc.”

“No thanks.”

“I think the overall appearance of the system can be
improved to make it more pleasing to look at. More options
for customization of the screen would also be nice, such as
the color, where different categories of information can be
placed on a page on the screen, etc”

“No, thank you?”
“Brighter colors, not as monochromatic”

“No”
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Exit Survey Results: Group 2
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2. ON THE SCALE BELOW, HOW EASY OR DIFFICULT DID YOU FIND USING THE SOFTWARE?

GROUP 2A GROUP 2B
6 6
5 5
4 4
3 3
2 = 2
1 - 1
0 - T T r , 4
(7) Very 6 5 4 3 2 (1) Very (7) Very 6 5 4 3 2 (1) Very
Likely unlikely. Likely unlikely.

3. WHAT PART OF THE TESTING DID YOU FIND WAS THE MOST CHALLENGING?

GROUP 2A GROUP 2B
“finding some of the requested “finding information...but once I got
information” used to the software, it was easy to

figure out which is where.”

“Finding certain information input but that is quickly “Adding the weight on health board”

learned after use”
“finding information. information hierarchy is a bit lost.

“finding some of the requested information” but once I got used to the software, it was easy to figure
out which is where”

“finding calorie information and what items I'd eaten.”
“finding some editing functions.”

“Occasionally it was difficult to judge how best to

proceed with a task” “I could not find the homepage icon so had to keep going
back to changing homepage set up to get back to that page”

>

“some questions required finding the links that I found

difficult if not impossible to locate. The smoking bit was “adding the smoking task—it was not obvious where that
tough! also those food photos in the lower right” should be done”
“Navigating through recording results and setting goals” “Nothing was terribly difficult, but I suppose acclimating

to the overall organization of the interface”
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4. WHAT PART OF THE TESTING DID YOU FIND THE EASIEST?

GROUP 2A

“the icons were intuitive. Pretty
much you would expect to find
information based on the image
you saw on the screen.”

“Info input”
“filling in information”

“the icons were intuitive. Pretty much you would expect to

find information based on the image you saw on the screen”

<« 24
on tape

“Using the cursor.”

GROUP 2B

“Reading/finding information once
I knew where I was going”

“Adding weight training as a personal exercise.”
“data entry and fave buttons.”
“input information, except for cigarette smoking”

“general navigation. The exercise section was very easy.
I ended up liking the nutritional section as well.”

“Reading/finding information once I knew where
I was going”

5. WHAT FEATURE OR INFORMATION WAS MOST VALUABLE TO YOU?

GROUP 2A

“The depot of health info on one
program.”

“The depot of health info on one program.”
“tracking components”

“Monitoring how I was keeping within my calorie goals.
Being able to graph the weight changes”

“The food journal, the connection to dr. appts, the sense of
agency in monitoring my own health and nutrition”

“Physical Exercise information.”

PIIM RESEARCH
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GROUP 2B

“the ability to track everything and
having interaction with physicians
on an on-going basis”

“the widgets”

“nutrition with the graphs and stuff. specially like the
pop-ups.”

“Vital history, diet and weight history, and exercise
performance”

“the ability to track everything and having interaction
with physicians on an on-going basis”

“tracking diet / exercise could be useful. I liked the goal
idea, to see how I was doing in general”

“Probably the graphical tracking of various metrics (vital
signs, exercise, etc.)”
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6. WHAT FEATURE OR INFORMATION WAS LEAST VALUABLE TO YOU?

GROUP 2A GROUP 2B

“all very valuable” “some of the vital signs section. Since
[ am not familiar with thinking about
myself in that...”

“Not sure”

“nothing in particular” “no”

“Hard to tell since it was all new.” “none”

“all very valuable” “some of the vital signs section. Since I am not familiar with
thinking about myself in that (Bm1 vs weight) it did not

“Nutritional Information” make complete sense. Perhaps after tracking it for a few

months, it will make more sense”
“Nothing stands out among the stuff T used”

7. WAS THERE ANYTHING YOU THOUGHT WAS MISSING FROM THE SOFTWARE?

GROUP 2A GROUP 2B
“For a first time user, a how-to’ on “Quick links from the home page to
how to navigate the system...” record meals or other activity...

There should be a quick link to
record these things...”

“Not sure.”

“personalizations/allergy information”

no!
“For a first time user, a ‘how-to’ on how to navigate the
system. But I know this was a test” “physician’s recommendations isn’t highlighted so much.
I think this should be more prominent, maybe in the form
“my photo! and my dr’s photos would be nice. Also a of a notification or like a unread message/mailbox.”
bigger logon for the program”
no

“Perhaps a ‘Help’ section, or FAQ section.”
“Quick links from the home page to record meals or other
activity. I will probably log in to record eating or exercise
several times a day. There should be a quick link to record
these things, instead of navigating a few pages”

“Hard to say (didn't get to explore all available
functionality). But in the nutrition/food diary section it
might have been useful to be able to get more detailed
nutritional information on the foods entered than just calorie
count (this could be in the software but I didn’t use it).”
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8. IF THIS SOFTWARE WERE AVAILABLE TO YOU, HOW LIKELY WOULD YOU BE TO USE IT?

GROUP 2A

. —

(7) Very 6 5 4 3 2 (2) Very
Likely unlikely.

COMMENTS

“All in one software on health
and food!”

“I have difficulty maintaining this
detail of information”

“Looks to be interesting and if my doctor could interact
with it I would use it more often”

>

“I have difficulty maintaining this detail of information’

“It stores my health info in one location. Ease of
communicating with health provider”

“All in one software on health and food!”

“It would require much more attention to detail than
I would be able to provide.”
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GROUP 2B

6

5

4

3

2

1 -

(7) Very 6 5 4 3 2 (1) Very
Likely unlikely.

“It’s a great way of monitoring
your health.”

“it is not something that I like
thinking about. It is a bit of a ‘nanny’
software...”

“It’s a great way of monitoring your health”

“it is not something that I like thinking about. It is a bit of
a ‘nanny’ software. Though I should try to pay attention to
it”

“There are other systems available, in more convenient
forms to me (e.g. iPhone apps), that provide the
functionality I'd probably find most useful (e.g. exercise/
diet tracking), and I don’t use them?”

“I'm in love with Nike+ software, unless this can top that,
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10. DO YOU HAVE ANY OTHER FINAL THOUGHTS OR COMMENTS YOU'D LIKE TO SHARE ABOUT YOUR EXPERIENCE?

GROUP 2A

“Excellent prototype.”

“overall feels pretty good, but some
features felt as though they should be
more personalized...”

“Need to change color scheme for more contrast.”
“overall feels pretty good, but some features felt as though
they should be more personalized, but instead led to
websites of generic information”

“When is this coming out! This was interesting?”
“Excellent prototype.”

“Sorry I am very exhausted! But very pleased to participate”

“Itis an intriguing program, in concept.”
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GROUP 2B

“I think this would be great for
everyone—great way to stay on top
of all health aspects. Only concern is
privacy.”

“At first I was nervous but once I knew where things were,
it became more easier to understand.”

“check nike+ or nike training. maybe an app will be useful
too, for easy access.”

“I think this would be great for everyone—great way to stay
on top of all health aspects. Only concern is privacy”
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